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Preface

Thank you for purchasing OKI Multifunctional Digital Systems. This manual explains how to use the e-Filing. Read this
manual before using your Multifunctional Digital Systems. Keep this manual within easy reach, and use it to configure an
environment that makes best use of the OKI MFP's functions.

Bl How to read this manual

0 Symbols in this manual

In this manual, some important items are descried with the symbols shown below. Be sure to read these items before
using this equipment.

A WARNING Indicates a potentially hazardous situation which, if not avoided, could result in death, serious
injury, or serious damage, or fire in the equipment or surrounding objects.

A CAUTION Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate
injury, partial damage to the equipment or surrounding objects, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Other than the above, this manual also describes information that may be useful for the operation of this equipment with
the following signs:

Tip Describes handy information that is useful to know when operating the equipment.
L Pages describing items related to what you are currently doing. See these pages as required.

0 Model and series names in this manual

In this manual, each model name is replaced with the series name as shown below.

Model name Series name in this manual
ES9455 MFP ES9455 MFP*1
ES9465 MFP/ES9475 MFP ES9475 MFP Series

*1  The e-Filing functions can be used only when a hard disk is installed.

0 Screens and Operation Procedures

¢ In this manual, the screens and the operation procedures in Windows are described for Windows 7.
The details on the screens may differ depending on how the equipment is used, such as the status of the installed
options, the OS version and the applications.

* If you use Windows Server 2008 R2, refer to the operation procedure for Windows 7, though the screens or the menu
names, etc. may differ.

* The illustration screens used in this manual are for paper in the A/B format. If you use paper in the LT format, the
display or the order of buttons in the illustrations may differ from that of your equipment.
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O Trademarks

* The official name of Windows XP is Microsoft Windows XP Operating System.

* The official name of Windows Vista is Microsoft Windows Vista Operating System.

* The official name of Windows 7 is Microsoft Windows 7 Operating System.

* The official name of Windows 8 is Microsoft Windows 8 Operating System.

* The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.

* The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.

* The official name of Windows Server 2012 is Microsoft Windows Server 2012 Operating System.

¢ Microsoft, Windows, Windows NT, and the brand names and product names of other Microsoft products are
trademarks of Microsoft Corporation in the US and other countries.

* Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, and TrueType are trademarks of Apple Inc. in the US and other
countries.

* Adobe, Acrobat, Reader, and PostScript are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

* Mozilla, Firefox and Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the U.S. and other
countries.

* IBM, AT and AlX are trademarks of International Business Machines Corporation.

* NOVELL, NetWare, and NDS are trademarks of Novell, Inc.

e Other company and product names given in this manual or displayed in this software may be the trademarks of their
respective companies.
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e-Filing OVERVIEW

This chapter describes overview of the e-Filing features and functions.

€-Filing Features...........o s 6
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e-Filing Features

The e-Filing is installed in a hard disk of this equipment. It allows you to store documents and to print/edit/manage the
stored documents.

This section describes the system of e-Filing for storing documents.

This function is available only when a hard disk is installed in the equipment.

Control Panel

Client Computer

Documents stored by the
printing operation (printer
driver)

Documents stored by the Documents stored by

copying/scanning operation

N\,

receiving Internet Fax / FAX

7~

EaPublic Box
[T Folder =| & E
oo lonne 48
= = B | B B E
= T U5 All users
UserBox
[:__JFoIder % % %
Foder | F F F 0 l
EEB |AFE
7 == L Specified users
(or administrators)

Public Box

The public box is an e-Filing created by default. All users can access it, so it is suitable to store shared documents which
any user may need to work with. Since the public box is a built-in system box, you cannot change the name of the box /
create a new box / delete the box.

User Box

The user box is an e-Filing that each user can create. The user box can be protected by a password to limit access. It is
suitable for specific users or an administrator to store confidential documents. You can also create a user box without
setting a password. In this case, all users can access the user box as well as the public box.

(Up to 200 user boxes can be created.)

Folders

You can create folders in each box. However, you can create only one level of folders within each box. You cannot create
subfolders within folders.
(Up to 100 folders can be created in a box.)
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Documents
Documents can be stored in a box or folder in the following methods.

(Up to 400 documents can be stored in a box or folder. / Up to 200 pages can be contained in a document.)

* Copying documents and storing to e-Filing

¢ Scanning documents and storing to e-Filing

* Printing documents in a client computer and storing to e-Filing

* Received Internet Faxes / received faxes are forwarded to store to e-Filing using forward functions.

* Received Internet Faxes / received faxes are forwarded to store to e-Filing using forward mailbox functions.

» Storing the received faxes is available only when FAX Unit (optional) is installed.
* Depending on the amount of data stored in e-Filing, it may take some time from when the equipment is turned on to
e-Filing becoming ready for use.

Tips

* For details of the forward functions, refer to the TopAccess Guide.
* For details of the forward mailbox functions, refer to the GD-1250/GD-1260 Operator's Manual for FAX Unit and
TopAccess Guide.
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e-Filing Functions

M Functions operated with this equipment

Below is a list of e-Filing functions that you can operate with this equipment. For details of the operation, see the
references described below.

QO Printing documents

The following functions allow you to print documents stored in the e-Filing.
* To print an entire document
P.12 “Printing an entire document”
» To print specified pages of the document for confirmation
3 P.15 “Test print”

Q) Storing documents

The following functions allow you to store documents in the e-Filing.
* To copy and store documents
[ P.17 “Copying and storing to e-Filing”
* To scan and store documents
3 P.22 “Scanning to e-Filing”

U Deleting documents

To delete documents in the e-Filing
3 P.25 “Deleting Documents”

0 Managing user boxes/folders

The following functions allow you to manage user boxes and folders in the e-Filing. You cannot create and edit folders in
boxes using the control panel. Folders can be created using a client computer.
* To create new user boxes
P.27 “Creating user boxes”
* To change the registered user box name and password
P.29 “Editing user boxes”
* To delete user boxes and folders
P.31 “Deleting user boxes/folders”
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M Functions operated with a client computer

Below is a list of e-Filing functions that you can operate with a client computer (e-Filing web utility). For details of the
operation, see the references described below.

e-Filing web utility supports only Windows. Mac OS and other computers are not supported.

0 Managing user boxes/folders

The following functions allow you to manage user boxes and folders in the e-Filing.

To create new user boxes and folders

P.44 “Creating user boxes and folders”

To delete user boxes and folders

P.47 “Deleting user boxes and folders”

To edit (renaming and changing Properties) user boxes and folders
P.50 “Renaming user boxes and folders”

P.54 “Modifying and displaying user box and folder properties”

0 Managing documents

The following functions allow you to manage documents stored in the e-Filing.

To display document image files in thumbnail view and list view
P.60 “Displaying documents”

To rename documents

P.61 “Renaming documents”

To delete documents

P.63 “Deleting documents”

To print documents (entire document/test print)
[ P.64 “Printing an entire document”

P.67 “Selecting test print”

To store documents by printing operation

[ P.70 “Storing documents”

To archive documents

P.73 “Archiving documents”

To send documents as Emails

[0 P.78 “Sending Email”

U Editing documents

The following functions allow you to edit documents stored in the e-Filing.

To display document and page Properties

[ P.89 “Displaying document and page properties”

To copy/cut pages from a document and paste them into another one
3 P.90 “Copying pages from one document to another”

To copy/cut pages from a document and save them as a new document
P.95 “Copying pages from a document to a box or folder”

To delete pages from a document

P.99 “Deleting pages from a document”

To insert blank pages into a document

P.101 “Inserting a blank page into a document”

To move pages within a document to arrange the page order

P.104 “Moving pages within a document”

To move documents between boxes or folders

3 P.107 “Moving documents”

To copy an entire document and insert them into another document
P.109 “Merging documents”

Tips

* You can import e-Filing documents into a client computer using TWAIN Driver and File Downloader.
* You can back up or restore documents in e-Filing and various settings of e-Filing using the e-Filing Backup/Restore

Utility.
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OPERATIONS WITH THIS EQUIPMENT

This chapter describes e-Filing functions that you can operate using the control panel of this equipment.
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Printing Documents

You can print documents stored in the e-Filing using the control panel of this equipment.
P.12 “Printing an entire document”
P.15 “Test print”

M Printing an entire document
You can print an entire document.

1 Press the [Filing Box] button on the control panel.
T

PRINT PQRS TV WXYZ

@®®©
e ®0®

(2] C) CLEAR

O DATA IN
/ MemoRry PRINTDATA  ATTENTION

2 Select the box that contains a document you want to print.
W eFLING 2

BOX NUMBER | ]

001 < 002 008 004
PUBLIC @ @ @ @
BOX
UserBox01 UserBox02 UserBox03 UserBox04 4
-
005 @ 006 = 007 ;: 008 @ 009 @ 21
UserBox05 UserBox06 UserBox07 UserBox08 UserBox09 ‘ v

BOX SETTING

JOB STATUS

Press or to switch the pages. You can also specify the box number (3-digit) using the digital keys.

¢ Password entry

When the password has been set to the selected user box, the password entry screen is displayed. In this case,
press [PASSWORD], enter the password using the digital keys or the on-screen keyboard, and then press [OK].

o v TEMPLATENS

[ Select BOX.

Enter BOX Password

BOX NUMBER 001

BOX NAME UserBox01

| PASSWORD
»

‘ CANCEL 0K

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access.
When “Box is locked.” appears and logging in cannot be performed, ask your administrator.

* The password input is displayed in the blank symbols.
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3 If the document is stored in a folder, select the folder and press [OPEN].

?; e-FILING 7 TEMPLATE , N

» 001 UserBox01 E EE]
Document / Folder Name Date,Time Paper Pages

B | Foiderod 11,0225

[ ] Dpocitosg 10,0432 A4 1 ;
h 4 =

|'L RETURN ‘ DELETE
BOX SETTING

If the document is stored outside of the folder, this operation is not necessary.

Select the document. To change the print settings, press [SETTINGS]. To perform
printing without changing them, press [PRINT].

© e-FILNG 7 TevPLATE |, I
» 001 UserBox01 P Folder01 E [EEE)
Document Name Date,Time Paper Pages
Q DOC110508 10, 06:04 A

4 1
I YT
-
\/ !

|¢_ RETURN ‘ DELETE ‘ SETINGS | | TESTPR\NT.H OPEN J ‘ & PANT j
B

JOBSTATUS

If you press [SETTINGS], proceed to step 5.
If you press [PRINT], printing will start. When you want to stop printing, see “Deleting print job” in step 6.

Tip

Press |EJEJEJ to preview thumbnail images of the documents. Select the desired one and press [OPEN] to

display its contents. Press | == | to return to the list.

¥ eFlNG ?
» 001 UserBox01 b Foider01 (1= |
Document Name >

bz 1

-

" 1

DOG110508 DOC110510
|4_ RETURN ‘ DELETE ‘ SETTNGS ‘ TEST PRINT ‘ OPEN ‘ & PRNT

BOX SETTING

JOBSTATUS
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5 Change the print settings as necessary.

3 4 5

B_e-FILIN I
SETTNGS
SET e——

e

« “Wl

N1
-

& =
% FNSHNG | §§]  tnay
»

@ 2.SDED
> >
NONE NONE

MAGE TME i PAGE
SHIFT 00:00°  STAMP Tz, NUMEER
> >

Ad
A3
Ad4R
B4

m

m

CANCEL I PRINT | I

You can operate the print settings as below. For step 3 to 8, when each button of the menu is pressed, the setting

screen appears. Perform the appropriate operations. These operations of settings are the same as the one of copy

modes. For details of the operation, refer to the Copying Guide.

1) Select the paper feeder. However, if the selected paper size is different from the actual one, the selection will be
cancelled and automatic paper selection will be applied.

2) Key in the number of copies to be printed using the digital keys.

3) Select the duplex printing mode. If you do not want to print on both sides of the paper, select [1 SIDE] in the
menu.

4) Select the finishing mode. The available finishing modes differ depending on the type of finishing device

installed.

Select the receiving tray. This button is available only when the Finisher (optional) is installed.

Set the position and width of the margin.

Set the position of the date and time to be printed.

Set the position of the page number to be printed.

6 Press [PRINT].

sle TEMPLATE .

) e n
SETTINGS
SET 9

=
o, S BT
c ‘@ 2S\DED’ 2 oee |y B0 3
.

>
NONE NONE NONE

W MAGE TIME o PAGE
SHFT  J|0000  sTAMP Z2;  NUMBER
> >

| CANCEL || @ _PRINT

s

~

~1

1

A4
A3

i}

A4R

[m

B4

¢ Deleting print jobs
Follow the procedure below to stop the printing of the document (delete print jobs).
1) Press [JOB STATUS].
2) On the job status menu, display the print job list or the scan job list.
3) Select the job you want to delete, and then press [DELETE].
4) The delete confirmation screen appears. Press [DELETE].
For details of deleting print jobs, refer to the Copying Guide.
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M Test print
You can print specified pages of the document for confirmation.

1 Press the [Filing Box] button on the control panel.

NN i

PRINT PQRS TV WXYZ

QRORO)
sy ®O©®

FAX AUTHENTICATION
[{&] Q CLEAR
O DATAIN
/ MEemory PRINTDATA  ATTENTION

2 Select the box or folder that contains documents you want to print.
W eFILNG ?

BOX NUMBER | ]

[0 < 002 003 004
PUBLIC @ @ @ @
BOX
UserBox01 UserBox02 UserBox03 UserBox04 4
P
005 @ 006 = 007 _-: 008 @ 000 @ 21
UserBox05 UserBox06 UserBox07 UserBox08 UserBox09 ‘ v

BOX SETTING

JOBSTATUS

The instructions of the operating procedure as to selecting a box/folder are omitted, because they are the same as
those for one of printing an entire document.
P.12 “Printing an entire document”

3 Select the document you want to print, and then press [TEST PRINT].

W e-FlLNG 7
» 001 UserBox01 E [EE:]
Document / Folder Name Date, Time Paper Pages
Folder01 11,0225
|j DOC110509 10,0432 A

4 1
] 0 N
W

[+ meTURN ” DELETE ” SETTNGS “

testeant |[ orev | [ PaNT )

PRINT BOX SETTING b

! JOBSTATUS ,

Tip

Press |EJEJEJ to preview thumbnail images of the documents. Select the desired one and press [OPEN] to

: = | to return to the list.

display its contents. Press
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4 Key in page numbers in [FIRST PAGE] and [LAST PAGE], then press [PRINT].

!\ e N s TEMPLATE .
TEST PRINT

Please enter a valid value

[ First Page ‘ -

4
| Last Page J ‘ 3 |

‘ All Pages_

| canceL || & PRNT
Ji ST

* Select [FIRST PAGE] or [LAST PAGE], then specify the page numbers using the digital keys on the control

panel.
If you press the [CLEAR] button on the control panel, the value entered in the currently selected box can be

deleted.
* To print entire pages of the document, press [ALL PAGES].

* Deleting print jobs
Follow the procedure below to stop the printing of the document (delete print jobs).
1) Press [JOB STATUS].
2) On the job status menu, display the print job list or scan job list.
3) Select the job you want to delete, and then press [DELETE].
4) The delete confirmation screen appears. Press [DELETE].
For details of deleting print jobs, refer to the Copying Guide.
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Storing Documents

You can store documents in e-Filing using the control panel of this equipment.
P.17 “Copying and storing to e-Filing”
P.22 “Scanning to e-Filing”

» Store confidential documents in a user box protected by a password.

* Up to 400 documents can be stored in a box or folder, and up to 200 pages can be contained in a document.
However, the total storage capacity of e-Filing and the shared folder is approx. 230 GB. Documents can only be
stored within the storage capacity limit. The available space can be checked with the [Device] tab in TopAccess.

¢ Saving in the e-Filing is not for permanent use. Delete unnecessary documents immediately.
P.25 “Deleting Documents”

Tips

* When you store documents in user boxes and folders, you need to create them in advance.
P.27 “Creating user boxes”(Operating with this equipment)
P.44 “Creating user boxes and folders” (Operating with a client computer)
* You can set the storage period for documents in the Box Properties window in a user box. The documents will be
deleted after the specific number of days have passed.
P.54 “Modifying and displaying user box and folder properties” (Operating with a client computer)

H Copying and storing to e-Filing

You can copy and store documents in e-Filing. The e-Filing documents can be copied and stored at the same time.

* Documents, whose paper sizes are shown below, cannot be stored in e-Filing.
- Custom paper
- Non-standard size paper (MPT)

¢ A document stored by “Copying and storing to e-Filing” is suitable for output, but not for importing as an image into
a client computer. To get the best image quality for importing an image into your computer, store the document by
“Scanning to e-Filing”.
P.22 “Scanning to e-Filing”

Place the original(s) and set the copy mode as necessary.
For details of placing original(s) and copy mode settings, refer to the Copying Guide.

On copy mode settings, even when “TWIN COLOR COPY” or “MONO COLOR” is selected on the [IMAGE] tab,
this mode is invalid for storing documents in e-Filing. This mode is also invalid for copying documents at the
same time as storing them.

2 Press [STORAGE] on the copying screen.

§AUTO v FULL
BN — 100% NON-SORT £®  COOR
ORG = COPY NON-STAPLE e

s &3
B zoom || rsina o
> »| %% color

121 o R
SIVPLEX TEXT /PHOTO ] —

}MPT -
A4 =]

A3

Ad4R = \ AUTO || » |
B4 El E@ 2-SDED ﬁ Rt
|§0UBT"P\‘UT| e > 4 ‘ PROOF COPY. I

BASIC EDIT IMAGE

4 JOBSTATUS ,

If the copying screen is not displayed, press the [COPY] button on the control panel.
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3 Press [STORE TO E-FILING].

@5 copy STORAGE , | SETTNGS , fl+¢ TEMPLATE , N
READY

SET

‘ COPY &FILE P
FOLDER BOX No I:'
»

BOX NAME

FOLDER NAME

DOCUMENT NAME _J ‘DOC‘ 10510 |

‘ RESET H CANCEL

4 Press [BOX/FOLDER].

g3 copy sTORAGE , | sETTnGs , l vy TEMPLATE , 2
READY

—— e
‘ BOX [ FOLDER BOX No. I:l
.

BOX NAME | ‘

SET

1

FOLDER NAME | ‘

DOCUMENT NAME .J ‘DO(H 10510 |

‘ RESET H CANGEL

5 Select the box in which you want to store the data.

¥ eFlNG 2

BOX NUMBER! -

01 002 = 003 004
PUBLIC @ @ @ @
BOX

UserBox01 UserBox02 UserBox03 UserBox04 I
—_—— —
005 @ 006 007 @ 008 @ 009 @ 21
UserBox05 UserBox06 UserBox07 UserBox08 UserBox09 ‘ v

‘ CANGEL t

Press or to switch the pages. You can also specify the box number (3-digit) the using digital keys.
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e Password entry
When the password has been set to the selected user box, the password entry screen is displayed. In this case,

press [PASSWORD], enter the password using the digital keys or the on-screen keyboard, and then press [OK].

) o se TEMPLATE .
Select BOX. 7

Enter BOX Password

BOX NUMBER 001

BOX NAME UserBox01

PASSWORD
>

‘ CANCEL oK

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access.
When “Box is locked.” appears and logging in cannot be performed, ask your administrator.

* The password input is displayed in the blank symbols.

6 To store the original(s) in the selected box, press [OK].

@5 copy STORAGE , | SETTNGS , | vv TEWPLATE , N 7
READY SET

1

» 001 UserBox01

Document / Folder Name: Date,Time Paper Pages
Folder01 11,0225
|] DOC110509 10, 04:32 A4 1 5

e Storing in a folder
Select the folder and press [OPEN], the list in the folder is displayed. To store the original(s) in the selected folder,

press [OK].

@3 copy STORAGE , | SETTNGS , fl <7 TEWPLATE , N2
READY =

1

» 001 UserBox01

Document / Folder Name: Date,Time Paper Pages
B | Foierod 11,0225
g DOC1105( I 10, 04:32 A4 1 :
—
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7 Change the document name as necessary, then press [OK].

STORAGE

T
‘ BOX [ FOLDER BOX No.
]

BOX NAME UserBox01
FOLDER NAME Folder01

‘ DOCUMENT NAME .J ‘DO(N 10510 |
&
[

w | REseT H CANCEL

001

* Renaming the documents

When you press [DOCUMENT NAME], the on-screen keyboard is displayed. Key in the document name using the
keyboard and the digital keys (up to 64 characters), then press [OK].

E E |
(om)_o)
EEEEEREREEEERNER
EEEEREEREREEE
EEEFEEEERE
EDEnDon <)
@JI Shift J ‘ Space J

‘ CANCEL l oK !

For details of the on-screen keyboard, refer to the Quick Start Guide.
Tips

* A character string composed of "DOC", year, month and date is displayed by default. This format can be
changed in TopAccess. For details, refer to the TopAccess Guide.

If the same name has already been stored, a serial number (-001, -002...) will be automatically added to the
end of the file name and stored.

When the copy confirmation screen appears, press [YES] to store and print the
document. If you want to store the document without printing it, press [NO].
?ﬁ COPY STORAGE , SETTNGS , fl 7% TEMPLATE , RN

| CONFIRMATION 2 ;

Print this document?

‘ CANCEL l T

JOB STATUS
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9

Press the [START] button on the control panel.
60 ==

Stop

Copying the next original

Depending on how the original is set, the confirmation screen to copy next the original may be displayed. Repeat

the procedure below as many times as necessary. When the scanning of the last page of the original finishes,

press [FINISHED].

* When the original is set on the glass, place the next original and press [YES]. When you press the [START]
button on the control panel, scanning will start.

* When the original is set on the RADF (Reversing Automatic Document Feeder)* in the SADF (single feed
mode), scanning will start when the next original is set. (You do not need to press any key.)
*  The RADF is optional.

= stonAce M seTTNGs M- TEWPLATE .
SCANNING ?
Place next original on glass. Press [START] or [INEXT COPY] to copy. E 1

Press [JOB FINISH] to complete scanning

SCANPAGE ‘

JOB GANGEL H JOB FNISH ” NEXT GOPY ]

JUDDIAIUS

Deleting scan jobs

Follow the procedure below to stop the scanning of the documents (delete scan jobs).
1) Press [JOB STATUS].

2) On the job status menu, display the scan job list.

3) Select the job you want to delete, and then press [DELETE].

4) The delete confirmation screen appears. Press [DELETE].

For details of deleting scan jobs, refer to the Scanning Guide.
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l Scanning to e-Filing

You can scan and store documents in e-Filing. When you import an original as an image into a client computer, it is
recommended to store the document using Scan to e-Filing.

To use this, the scanning function is required.

Place the original(s).
For details of placing original(s), refer to the Copying Guide.

2 Press the [SCAN] button on the control panel.

\ MEeNU SETTING INTERRUPT COUNTER
CH) O
Copy

‘ ABC DEF
SCAN GHI JKL MNO
PRINT PQRS TUV_ WXYZ

3 Press [e-FILING].

& SCAN SETTNGS , | o TEMPLATE , I

Select Menu!!

‘ Y

FILE J @ E-MAL H >3

0 -
| SCANSETTNG ,

Destination File Name File Format ‘ @&l PREVEW
.

—
f

 JOBSTATUS ,

Tip

Set [SCAN SETTING] and check [PREVIEW] as necessary. These operations are the same as the one of other
scanning functions. For details of the operation, refer to the Scanning Guide.

[PREVIEW] can be selected only when any of the following models is used.
- ES9455 MFP (only when a hard disk is installed)
- ES9475 MFP Series
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Select the box or folder in which you want to store the documents. Change the
document name as necessary, then press [OK].

& SCAN SETTNGS , ] 7x TEVPLATE , B
Select Menu!!

‘ BOX / FOLDER

BOX No. 001

BOX NAME UserBox01
FOLDER NAME Folder01

‘ DOCUMENT NAME ”DOC11[)510 ‘
»

'}

The instructions of the operating procedure as to selecting a box/folder and changing a document name are
omitted, because they are the same as those for copying and storing to e-Filing.
P.17 “Copying and storing to e-Filing”

Press [SCAN].

& SCAN SETTNGS , ] &5 TEVPLATE , )

Select Menu!
Press SCAN to start scanning.

‘ ED e-FILNG H b FLE J
5

|‘/@_ E-MAL H(‘/ﬂ UsB J

‘ SCANSETTNG |

Destination File Name File Format ‘ @l PREVEW
1 :’a UserBox01 DOC110510 1
P

When the original is set on the RADF (Reversing Automatic Document Feeder)’, pressing [CONTINUE] on the
screen during scanning can start the scanning of another original after the current one.

P.24 “Scanning the next original”

*  The RADF is optional.

The acceptable number for reserving scanning jobs differs depending on the settings. If the reserved jobs
exceed the corresponding number, the full reservation message will be displayed. In this case, wait until the
reserved scanning jobs are reduced or delete unnecessary reservations (scanning jobs) as described below.
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e Scanning the next original
When the original is set on the glass or [CONTINUE] is pressed during scanning on the RADF, the confirmation
screen for the next original will be displayed.
In either case, when you set the next original and press [SCAN], it will be scanned. Follow this procedure as many
as times as necessary. When all of the scanning is finished, press [JOB FINISH].

SETTNGS .M 5 TEMPLATE .

AN
SCANNING

‘JOBGANCEL ‘SOANSETT\N@‘ JOB FINISH |® SCAN l ‘

JUBSIAIUS

* You can change the scan setting by pressing [SCAN SETTING].
* You can cancel the reservation of the scanned data by pressing [JOB CANCEL].

¢ Deleting scan jobs
Follow the procedure below to stop the scanning of the documents (delete scan jobs).
1) Press [JOB STATUS].
2) On the job status menu, display the scan job list.
3) Select the job you want to delete, and then press [DELETE].
4) The delete confirmation screen appears. Press [DELETE].
For details of deleting scan jobs, refer to the Scanning Guide.
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Deleting Documents

You can delete documents in e-Filing using the control panel of this equipment.

e-Filing is not designed for saving documents permanently. Delete unnecessary documents immediately.

Tip
If you delete a folder or box, all the documents in the folder or box are deleted as well.
P.31 “Deleting user boxes/folders” (Operating with this equipment)
P.47 “Deleting user boxes and folders” (Operating with a client computer)
1 Press the [Filing Box] button on the control panel.

S\ TV

PRINT PQRS TUV WXYZ

©JOXO.
e ®0®

(2] C) CLEAR

O DATAIN
/ Memory PRINTDATA  ATTENTION

2 Select a box or folder that contains a document you want to delete.

¥ e-FILNG ?

BOX NUMBER | ]

01 = 002 003 = 004
PUBLIC @ @ @ @
BOX
UserBox01 UserBox02 UserBox03 UserBox04 4
—
005 @ 006 = 007 ;j 008 @ 009 @ 21
UserBox05 UserBox06 UserBox07 UserBox08 UserBox09 ‘ v

BOX SETTING

JOB STATUS

The instructions of the operating procedure as to selecting a box/folder are omitted, because they are the same as
those for printing an entire document.
P.12 “Printing an entire document”
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3 Select the document you want to delete and then press [DELETE].

?; e-FILING Y TEMPLATE , N3
» 001 UserBox01 E (L]
Document / Folder Name Date,Time Paper Pages
Folder01 11,0225

g DOC110509 10,0432 A4 1
MF i
W/

|'L RETURN ‘ DELETE ‘ SETTINGS ,J

PRINT BOX SETTING

TEST PRINT JI OPEN “ & PRNT j
>

W JoBsTATUS |

Tip
Press EEJEJI to preview thumbnail images of the documents. Select the desired one and press [OPEN] to

: = | to return to the list.

display its contents. Press

When the confirmation screen appears, press [DELETE] to delete the selected
document.

W eFlLNG 2

E

Pages

» 001 UserBox!

Folder01
[] pocito

1
B o =
- ‘ DELETE l CANCEL ] 1

Are You sure you want to delete this document?

[+ RETRN & PRNT j

PRINT BOX SETTING

JOB STATUS

You can cancel the deletion of the selected document by pressing [CANCEL].
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Managing User Boxes/Folders

You can manage user boxes and folders in the e-Filing using the control panel of this equipment.
P.27 “Creating user boxes”

P.29 “Editing user boxes”
P.31 “Deleting user boxes/folders”

Tip

Folders can be created and edited using a client computer.

P.44 “Creating user boxes and folders”

P.50 “Renaming user boxes and folders”

P.54 “Modifying and displaying user box and folder properties”

H Creating user boxes
You can create user boxes (up to 200).

1 Press the [Filing Box] button on the control panel.
T

PRINT PQRS TUV WXYZ

®®O
e ®06

@ D) Cuear
O DATAIN
/ Memory PRINTDATA  ATTENTION

2 Press the [BOX SETTING] tab, select an unregistered button numbered from “001” to
%2007, then press [SETUP].

¥ e-FiLNG ?

BOX NUMBER! 011

010 @ 012 kg 013 @ 014 @ EJ

UserBox 10 2

015 @ [ ots 017 @ 018 @ 019 @ g
y &

BOX SETTING

4 JOBSTATUS ,

Press or to switch the pages. You can also directly specify the box number (3-digit) the using digital keys.
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3 Press [BOX NAME] and enter the box name.

'\ e N s TEMPLATE .
BOX SETUP ?
Enter BOX name and Password

Box No 011

| BOX NAME
»
| }SSWORD } | ‘
»

| RETYPE PASSWORD } | ‘
»

‘ CANGEL '

JOBSIAIUS

* Entering box name
Press [BOX NAME]. The on-screen keyboard is displayed. Key in the box name (up to 32 characters) using the
keyboard and the digital keys, then press [OK]. However, the following one-byte characters cannot be used. A
space or period cannot be used at the beginning or end of the name. If these characters are keyed in, an error
message informing you of the invalid character used is displayed.
"B &'=|{}"<>?[];:/\,

UserBox11_

B
| Back Space ‘ Clear

EEEEEEL =

‘ﬁ" Shift J ‘ Space J
‘ CANCEL l 0K !

For details of the on-screen keyboard, refer to the Quick Start Guide.
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4 Enter the password in the [PASSWORD] and [RETYPE PASSWORD] boxes, then press
[OK].

§ e N se TEMPLATE .
BOX SETUP ?

Enter BOX name and Password.

Box No 011

| BOXNAME | UserBox 11
»

| PASSWORD ] | ****** ‘
»

| RETYPE PASSWORD } | ***** ‘
»

S

* Press [PASSWORD] and then [RETYPE PASSWORD]. Enter the password using the digital keys or the on-
screen keyboard. You can also create a user box without setting a password. In this case, all users can access

the user box as well as the public box.
* If you press the [CLEAR] button on the control panel, the value entered in the currently selected box can be

deleted.

» If the entered password does not meet the Password Policy, a warning message appears. Enter the correct
one.
For details of the Password Policy, refer to the TopAccess guide.

* The password input is displayed in the blank symbols.

M Editing user boxes
You can change the registered user box name and password.

1 Press the [Filing Box] button on the control panel.
T

PRINT PQRS TUV WXYZ

©JOXO.
FILING Box @ @ @

(2] C) CLEAR

O DATAIN
/ MemoRry PRINTDATA  ATTENTION

;a
x
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2 Press the [BOX SETTING] tab, select the user box that you want to edit, and then press

[EDIT].
¥ eFiLNG 2
BOX NUMBER 011

W 011 tﬂ 012 @ 013 @ 014 @ EJ
UserBox 10 UserBox 11 2
015 b 017 018 018 g
J \ P J I |
v

| DELETE ‘ EDT o

BOX SETTING

Press or to switch the pages. You can also directly specify the box number (3-digit) the using digital keys.

e Password entry
When the password has been set to the selected user box, the password entry screen is displayed. In this case,
press [PASSWORD], enter the password using the digital keys or the on-screen keyboard, and then press [OK].

B e-FIN
BOX MODIFY

Enter BOX Password

s TEMPLATE

I

BOX NUMBER 011

BOX NAME UserBox 11

Tips

* You can also enter the administrator password to open the user box instead of the password.
* The password input is displayed in the blank symbols.

Change [BOX NAME] / [PASSWORD] / [RETYPE PASSWORD] as necessary, and then
press [OK].

B o-FILN
BOX MODIFY

Enter BOX name and Password

52 TEMPLATE

BOX NUMBER: : 011

| BOX NAME _J ‘UserBoxﬁ

| PASSWORD J | ***** ‘
»

| RETYPE PASSWORD J | “““ ‘
»

The instructions of the operating procedure of [BOX NAME] / [PASSWORD] / [RETYPE PASSWORD] settings are
omitted, because they are the same as those for creating user boxes.
P.27 “Creating user boxes”
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H Deleting user boxes/folders

You can delete user boxes and folders.

If you want to delete a folder or a box, all documents in the folder or the box are deleted as well.

1 Press the [Filing Box] button on the control panel.
T

PRINT PQRS TUV WXYZ

©JOXO.
e ®0®

(2] @ CLEAR

O DATAIN
/ Memory PRINTDATA  ATTENTION

2 Follow the procedure below to delete user boxes and folders.
* Deleting user boxes
Press the [BOX SETTING] tab, select the user box you want to delete and then press [DELETE].
¥ eFLNG ?

BOX NUMBER m

> (G 3 e [
UserBox 10 UserBox 11 2
B —~
i "3 1"
)

| DELETE ‘ EDMEEEN

BOX SETTING

2011/05/ 10
AEBH  J0BSTATUS |,

The instructions for the operating procedure for selecting user boxes are omitted, because they are the same as
those for editing user boxes.
P.29 “Editing user boxes”

¢ Deleting folders
Press the [PRINT] tab, select the folder you want to delete and then press [DELETE].

W eFLING vr TEMPLATE , NG

» 011 UserBox 11 E [
Document / Folder Name: Date, Time Paper Pages

B | Foierod 10,0747

[) poctioses J ¥ 10,0748 Ad 1=

[ poctiosio N 10,0748 A4 3|

|¢_ RETURN ‘ DELETE

PRINT M BOX SETTING

BB 0B STATUS |

The instructions for the operating procedure for selecting folders is omitted, because it is the same as the one of
printing an entire document.
P.12 “Printing an entire document”
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3 When the confirmation screen appears, press [DELETE] to delete the selected box/

folder.
¥ e-FILNG 2
| ATTENTION
BOX NUMBER!
010
I A
UserBox 10 Are you sure you want to delete this box?
(Document in the BOX are also deleted) ;
015 ) 2t
@ ‘ DELETE | CANCEL I
v
| oeetE
BOX SETTING

B JOBSTATUS

You can cancel the deletion of the selected box/folder by pressing [CANCEL].
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OVERVIEW OF e-Filing WEB UTILITY

This chapter provides an overview of the e-Filing web utility features.
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Before Using the e-Filing Web Utility

Before using the e-Filing web utility, check the following items on your computer.

P.34 “System requirements”

System requirements

The e-Filing web utility works with the following browsers for the Microsoft Windows operating system:
* Microsoft Internet Explorer 6.0 or later (Internet Explorer 7.0 or later when IPv6 is used)

¢ Firefox 3.5 or later

e The minimum display resolution required for these browsers is 800 x 600.

* When using Internet Explorer, the Privacy setting must be set to Medium on the browser. Do not set Block All Cookies
or High for the Privacy function. For instructions on the Privacy setting, see the following procedure.

* Disable the popup block function of the Web browser. For instructions on how to set the popup block function, refer to

the HELP for the Web browser you are using.

e-Filing does not support access from Safari.

How to set the privacy settings in Internet Explorer

When you are using Internet Explorer, make sure that the Privacy setting is correct as follows.

1 Launch Internet Explorer and select [Internet Options] in the [Tools] menu.

{6 TopAccess - Windows Intemet Explorer

@Vv (&) nttps//192.168.0.L L MAIN=DEVICE

FEile Edit View Favorites [NCTIHS Help

S Favorites | 33 ] Sugge

& TopAccess

Device

Ctrl+Shift+Del
Ctrl+Shift+P

Delete Brawsing History..
InPrivate Browsing
Diagnase Cannection Problems

Reopen Last Browsing Session

InPrivate Filtering Ctrl+Shift+F

InPrivate Filtering Settings
Pop-up Blocker
SmartScreen Fifter

Manage Add-ons

Compatibility View
Compatibility View Settings

Subscribe to this Feed.

Feed Discovery

Windaws Update

Developer Taols F12
Onellote Linked Motes.

Lync Click to Call

Send to Onehlote

Internet Options N

i\mn Counter
»

Ready

2048 MB

512 MB

Space Avallable

TB054 MBI

943 MB

Optiens

[
l'\? | Phone Hurnber

The [Internet Options] dialog box appears.

2 Display the [Privacy] tab and move the slider to “Medium” and click [OK].

Internet Options

(BN

| General [ security | Privacy | content | connections | Programs | advanced |

Settings I
L

Select a setting For th® nternet zone,

Medium

- Blocks third-party cookies that do not have & compact
privacy policy

- Blocks third-party cookies that save information that can
be used ta contact you without your explicit consent

- Resticts first-party cookies that save information that
<an be used to contact you without your implicit consent

[ stes ][ 1ot ][ advanced Defaulk

Pap-up Blocksr

1| Prevent most pop-up windows From
*| appearing.

[ Turn an Pop-up Blacksr

Settings

InPrivate
C 1) [Cloonat collect dats for use by Inprivate Fikering

E;:?::s\e toolbars and extensions when InPrivate Browsing

P

N3

The Privacy setting is saved.
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3 Exit from Internet Explorer and launch it again before accessing e-Filing.

Exit from Internet Explorer after accessing the e-Filing web utility. To log off from the e-Filing web utility in the
user mode, click the Log-out link and then exit from Internet Explorer.
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Getting Started With the e-Filing Web Utility

This section describes how to launch and exit from the e-Filing web utility. The way to launch the utility differs depending
on whether you log in as a user or a system administrator.

P.36 “Logging in as a user”
P.37 “Logging in as a system administrator”

M Logging in as a user

There are two ways to access the e-Filing web utility:

Click the e-Filing web utility link in the TopAccess web site.
Enter the e-Filing web utility URL in the address field of your Web browser.
The e-Filing web utility URL is: http://[IP address]/?MAIN=EFILING
The [IP address] portion will be the IP address of this equipment. You can also use the DNS name of this equipment
instead of the IP address.
For example, the IP address of this equipment is 192.168.1.2
http://192.168.1.2/?MAIN=EFILING
For example, the DNS name of this equipment is mfp-00000236
http://mfp-00000236/?MAIN=EFILING

If SSL is enabled for the HTTP network service, the e-Filing web utility will also be accessed by using SSL.

When the User Management Setting has been enabled, the log-in page will be displayed when accessing the e-Filing web
utility URL. In that case, please enter your User Authentication user name and password to log in to the main page of the
e-Filing Web Utility.

Login with your TopAccess User Mame and Password,

User Name Userl1
Password ssssss
Domain dept0l

¢ If you enter an invalid authentication password several times to log into the OKI MFP, you may not be able to log in
for a certain period since it will be regarded as an unauthorized access.
* The password input is displayed in the blank symbols.

Tips

* Users can launch the e-Filing web utility to use its functions.

* Access to the e-Filing web utility will be timed out according to the Session Timer setting in the WEB General
Setting of TopAccess.

* To use the administrator’s functions of the e-Filing web utility, you must log in as a system administrator after
accessing it.
P.37 “Logging in as a system administrator”
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M Logging in as a system administrator

To log in as a system administrator, follow the steps below after launching the e-Filing web utility.

"System administrator" and "User with an administrator privilege" are defined as follows in this manual.
- System administrator:

User with the administrator role
- User with an administrator privilege:
User whose ID is "Admin"

1 Click the Log-in link located at the upper right of the page.

Documents Preferences L u:irl

The Administrator Log-in page is displayed.

2 Enter the administrator password in the [Password] box and click [Login].

(¢ Electronic Filing

Administrator Login

e

Top | Help

The [Administration] tab appears in the main tabs.

* If you enter an invalid authentication password several times to log into the e-Filing web ultility in the
administrator mode, you may not be able to login for a certain period since it will be regarded as an
unauthorized access.

* To log off from the e-Filing web utility in the administrator mode, click the Log-out link and be sure to close
your web browser to prevent unauthorized access by other users.

Tips
* The administrator password is the same as the password that has been set in the TopAccess or touch panel

display for the administrator. The default administrator password is “123456” if you have not changed it.
* The password input is displayed in the blank symbols.
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About the Main Tabs

The user interface of the e-Filing web utility consists of three main tabs located in the upper-right corner of the web
browser’s window: the [Documents] tab, [Preferences] tab, and [Administration] tab.

Documents Preferences Administration Logout

These main tabs enable you to display and work with your documents, set up viewing preferences, and perform
administrative functions.

P.38 “[Documents] tab”

P.40 “[Preferences] tab”

P.41 “[Administration] tab”

In addition, the Log-in link is located to the right of the main tabs which allows you to log in as a system administrator.
P.42 “Log-in link”

H [Documents] tab

The [Documents] tab is the default page and is available to all users. It consists of the Folders and Document frame, the
Menu Bar, and the Contents frame.

2 3
|
g Electronic Filing | Login
| __[[s@sine <> |
Document B eFiling @ items)
1 — (& e-Filing

[l Public Box
5ﬁ 001 User0l
& 002 Userd2
&7 003 UserD3 @ ga ga ga —_— 4
gl D04 Userd4 ] ] ]

5ﬁ 005 Userds
& D06 Userds
&gl 007 Userd?

[FlPublic Bax o001 userol o0z useroz [0z useros

Aol 2 2 2

[Floo4 usero4 [Toos useros [FJoos useros 007 usera?

< b
Top | Help
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1) Document Frame
The Document frame is an Explorer-style user interface. Use the Folders and Document frame to locate the folders
and documents with which you want to work.
In the Document frame, the following icons are displayed according to the items:

Box Icons

This icon indicates a closed box.

This icon indicates an opened box.

This icon indicates a closed box that is protected by a password.

This icon indicates an opened box that is protected by a password.

Folder Icons
This icon indicates a closed folder.

This icon indicates an opened folder.

D RE &,

Document Icons

r‘ = This icon indicates a document that was stored by a print operation. When the icon is displayed on a
& Igl white background, it indicates that the document is currently in the View mode. When the icon is
displayed on a blue background, it indicates that the document is currently in the Edit mode.

|=! =8 This icon indicates a document that was stored by a scan operation. When the icon is displayed on a
5 white background, it indicates that the document is currently in the View mode. When the icon is
displayed on a blue background, it indicates that the document is currently in the Edit mode.

= |E| This icon indicates a document that was stored by a copy operation. When the icon is displayed on a
LA ["] white background, it indicates that the document is currently in the View mode. When the icon is
displayed on a blue background, it indicates that the document is currently in the Edit mode.

|=I =8 This icon indicates a document that was stored by a fax operation via the mailbox function, fax received
[ﬁ' liEI forward function, or Internet Fax received forward function. When the icon is displayed on a white
background, it indicates that the document is currently in the View mode. When the icon is displayed on
a blue background, it indicates that the document is currently in the Edit mode.

This icon indicates a document that was created by merging several documents. When the icon is
displayed on a white background, it indicates that the document is currently in the View mode. When
the icon is displayed on a blue background, it indicates that the document is currently in the Edit mode.

2) Menu Bar
The Menu bar is located below the main tabs: File, Edit, View, and Layout.

3) Tool Bar
The Tool bar is located below the main tabs: Send Email, Save, Test Print, Cut, Copy, Paste, Beginning, Previous,
Next, and End. These buttons provide you with a one-click access to various functions.

Click this button to send the selected documents as Email.

Click this button to save the document. This is enabled only when you are displaying the document in the Edit
mode.
Click this button to perform a test print.

Click this button to cut the selected documents or pages.

Click this button to paste the items that have been copied.

Click this button to display the first items in the Contents frame.
Click this button to display the previous set of items in the Contents frame.
Click this button to display the items that immediately follow those displayed in the Content frame.

Click this button to display the last items in the Contents frame.

=
Click this button to copy the selected documents or pages.
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4) Contents Frame
The Contents frame displays the documents or pages with which you are working. There are also document control
buttons located below the menu bar. You can use these buttons to change the document status between the View
mode and Edit mode, and use the Contents frame to print and edit your documents.

Tip

For more information about the document control buttons, see the following section:
P.88 “About the Document Control Buttons”

M [Preferences] tab

The [Preferences] tab is available to all users. It allows you to make the default condition for document viewing and the
number of thumbnail images displayed on the screen.

< Electronic Filing Login
Preferences
41 —— Default Document view:  Thumbnail view -

2 —lpad 8 0+ thumbnails per view.

3 —_— Display the progress bar.

4 —{5) [t
5 —

Top | Help

1) Default Document View
You can select the Thumbnail or List view. The system displays your documents by the selected view until you choose
another option from the View menu. The default is the Thumbnail view.

2) Load [number] thumbnails per view.
Use the drop-down list box to select the number of thumbnail images displayed on the screen as 4, 8 or 12. The default
is 8.

3) Display the progress bar.
Select the [Display the progress bar.] check box to display the progress bar when copying, cutting, or pasting the
documents or pages, deleting pages, or saving documents.

4) [Save]
Click this button to apply your new settings.

5) [Reset]
Click this button to restore the default settings.
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H [Administration] tab

The [Administration] tab allows the system administrator to manage the data in e-Filing. The [Administration] tab is only
visible if you are logged on as the system administrator.

The [Administration] tab has the following subtab:

P.41 “[Box Management] subtab”

Tip

An administrator can also set up the e-Filing notifications by using TopAccess in the administrator mode. For more
information about setting up the notifications for e-Filing, refer to the TopAccess Guide.

0 [Box Management] subtab

This subtab enables you manually to delete user boxes that are no longer required or have become corrupted. Use this
feature to restore the available hard disk space.

You can also unlock user boxes which have been locked by incorrect password entries.

(@ Efectronic Filing Logam
Box Management
4 — efFiling Disk Space Available - 10142 MB

Stored Data Data Type Data Size Remarks
Box Shared File a7 me

2 — A Box Number Box Name Used capacity Status

oot User01 57 MB
0oz Usernz 5KB
003 Usern3 sKB
004 User04 40mB
nos User0s 5K8

DDDDDDDI;EJ

nog User06 SKB
no7 User0? 5KB

Top | Help

1) e-Filing Disk Space Available
This item displays the available hard disk space for storing the e-Filing data.
2) Box Number / Box Name / Used capacity / Status
This item displays a list of all user boxes. When you click a box number or box name link, the Box Properties window

opens and you can see the detail properties of the box. If the user box is locked, the lock status is displayed in the

results. To delete or unlock a user box, select the check box on the left of each property, and then click [Delete] or
[Unlock].

3) [Delete]

Click this button to delete the selected boxes. Before doing so, first select the check boxes of the user boxes that you
want to delete.

Tips

* You cannot delete the public box.

* For instructions on how to erase user boxes, see the following section:
P.114 “Erasing boxes”

4) [Unlock]

Click this button to unlock the selected boxes. Before doing so, first select the check boxes of the user boxes that you
want to unlock.

Tip

For instructions on how to unlock the user boxes, see the following section:
P.115 “Unlocking user boxes”
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M Log-in link

The Log-in link that is displayed next to the main tabs allows you to log in as a system administrator.
P.42 “Administrator log-in page”

You can perform the administrative function from the [Administration] tab that will be displayed after you log in as a system
administrator.

P.41 “[Administration] tab”

O Administrator log-in page
You must enter the system administrator password to log in as an administrator.

@ Electronic Filing

Administrator Login

| —Fssewers eesess
2 — o
3 —

Top | Help

1) Password
Enter the system administrator password that is same as the administrator password on the touch panel display and
TopAccess.
2) [Login]
Click this button to log in as a system administrator.
3) [Cancel]
Click this button to cancel login and return to the main page.
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HOW TO MANAGE USER BOXES/FOLDERS

This chapter provides instructions on how to manage user boxes and folders by using the e-Filing web utility.

Managing User Boxes and Folders ... 44
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Managing User Boxes and Folders

The e-Filing web utility provides two box types: the public box and user box. Each user can create his or her own user box,
and also create one level of folder in each box.

This section explains the following operations:

P.44 “Creating user boxes and folders”

P.47 “Deleting user boxes and folders”

P.50 “Renaming user boxes and folders”

P.54 “Modifying and displaying user box and folder properties”

Tip

For a detailed explanation of the public box and user box, see the following page:
P.6 “e-Filing Features”

H Creating user boxes and folders

Each user can create his or her own user box, and also protect the box with a password, if required.
P.44 “Creating user boxes”
P.45 “Creating folders”

U Creating user boxes
This operation allows you to create up to 200 user boxes and protect each box with a password.
Tip

You can also create user boxes from the control panel. For instructions on how to create user boxes from the control
panel, see the following page:
P.27 “Creating user boxes”

Click the [Documents] tab.
The [Documents] tab page is displayed.

Make sure that you are selecting “e-Filing” in the Document frame, and select [New
Box] from the [File] menu.

(§ Electronic Filing
File Edit. View

Document
1 e~Filing
[ Public Box
@001 User0i 1
&7 002 User0z
&) 003 Usernd @ @ %
57 004 Userns o o ]
5§ 005 Userns
57 006 UserD6
g 007 Usern?
[CJont Usernl [CJonz useroz [[Jon3 useros
fad i i A

o004 Userns [oos Userns o0& Userds (007 Usern?

L] 3
Top| Help

The New Box window appears.

3 Define the box properties as required and complete the operation.

1) Select a box number in the [Box Number] box.
Users cannot select existing box numbers in the [Box Number] box. Only undefined box numbers appear in this
drop-down list box.

2) Enter the box name in the [Box Name] box.
Box names can consist of any ASCII characters except: \/<>"% & =";:*? | #[]{}. Do not use a space or
period at the beginning or end of the name. The maximum size of a box name is 32 characters.

3) If you want to protect the box with a password, enter one in the [Box Password] and [Confirm Password] boxes.
The password input is displayed in the blank symbols.
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4) Click [OK].

New Box
Required
Biox Murnber: o0& - %1
*Box Name: Userg
Box Passwaord: sssses %2
Retype Password ssssse
N3
A
Vg

The created user box appears in the Document frame.

Tip
Users can configure advanced properties for each box such as how long the box will retain documents, and

Email notification features.
P.54 “Modifying box properties”

U Creating folders

This operation allows you to create up to 100 folders in each box.

Only single-level folders can be created in each box. You cannot create subfolders in the folders.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box where you want to create a folder.

(¥ Electronic Filing
File

Document B eFiling @ terms)
{8 e-Filing

g Public Box
éa 001 User0l
g 002 UserDz
éa 003 User03 @ @
&0 004 UserD4
éa 005 User0s
0 006 Userds
éa 007 UserO?

[ rublic Box [[loo1 usero1
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber ont

Box Mame User1

Box Password :

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be

performed, ask your administrator.
* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].

4 Click the [File] menu and select [New Folder].

(g Electronic Filing

Document
18 e-Filing Open K

= g Public Box fename

= &9 001 User0dl
&7 002 Usern2
0 003 Userds
& 004 User0s
0 005 Userns
& 006 User0&
&g 007 Usern?

Archive Document
Upload Archived Document.

Test Print.
Print Document

Properties

Send Email

The New Folder window appears.

5 Enter the folder name in the [Name] box and click [OK].

New Folder

m
Mame: Gnlder‘m )

\

The created folder appears under the selected box in the Document frame.

Folder names can consist of any ASCII character except\/<>"% &=";:*?|#[]{}. Do not use a space or
period at the beginning or end of the name. The maximum size of a folder name is 64 characters.
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H Deleting user boxes and folders

This operation allows you to delete user boxes and folders.
P.47 “Deleting user boxes”
P.48 “Deleting folders”

Tip

When the box has been protected with a password, you must enter it to delete the box and folders. Users with an
administrator privilege can delete all user boxes and folders by using their password.

Folders in the public box can be deleted, although you cannot delete the public box itself.

U Deleting user boxes

This operation allows you to delete user boxes. If a user box is deleted, all folders and documents in the box are also
deleted.

Tip
You can also delete user boxes from the control panel. For instructions on how to delete user boxes from the control

panel, see the following page:
P.25 “Deleting Documents”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the user box that you want to delete.

(¥ Electronic Filing
File Edit. View Layout

Document B e-Filing & items)
18 e-Filing

FA Public Box
¥ Z@ 001 UserDl
Eﬁ 002 User02
50 003 UserD3 63
Eﬁ 004 User04
&g 005 UserDs

Ea 006 UserO6
&g 007 Userd?

[FlPublic Bax [Floo1 userol

3 If you select a user box which is protected with a password, the Password
Authentication window appears. Enter the password in the [Box Password] box and
click [OK].

Password Authentication

Box Mumber: oot

Box Marme : Userl1

Box Password asssss

» If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Click the [Edit] menu and select [Delete].

(¢ Electronic Filing
et wvew oo |

Document b JUEL Select All
Invert Selection
{8 e-Filing -
= Mg Public Box g“‘
opy
E & 001 Usernl
Bl &9 Folderol

ga 002 User02
0 003 Userds
ga 004 User04
&g 005 Userds
ga 006 UserO&
&g 007 Usern?

N

[CIFoldero1

The confirmation message dialog box appears.
B Click [OK].

Message from webpage

@R Doyouwant to delete the itemis)?

001 User0L

Cancel

The selected box is deleted.

U Deleting folders

This operation allows you to delete folders in the public box and user boxes. If a folder is deleted, all documents in the
folder are also deleted.

Tip
You can also delete folders from the control panel. For instructions on how to delete folders from the control panel, see

the following page:
P.31 “Deleting user boxes/folders”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box containing the folders that you want to delete.

(¢ Electronic Filing

Document i e-Filing (3 items)

{8 e-Filing

5@ 001 UserDl

Ea 002 User02
0 003 UserD3 63 ﬁa
Ea 004 User04 ﬂ

g 005 UserDs

Eﬁ 006 Userlf
Eﬁ 007 Userd?

[Crublic Box [[loo1 usero1
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber ont

Box Mame User1

Box Password : ssssss

All folders and documents in the box are displayed in the Contents frame. n

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check boxes of the folders that you want to delete and select [Delete] from
the [Edit] menu.

(g Electronic Filing
File Edit

Document
Invert Selection
18 e-Filing
E g Public Box g:lw
= 49 001 User0dl
= 3 Folderol

&0 002 Usernz
ga 003 User03
0 004 Usern4

ga 005 Userds J

\derDl

The confirmation message dialog box appears.

You can also delete a folder by selecting the folder in the Document frame, clicking on the [Edit] menu and
selecting [Delete]. In that case, make sure that no documents are selected in the Contents frame. If any
documents are selected, they will be deleted instead of the selected folder.

5 Click [OK].

Message from webpage ===

0 006 Userds
ga 007 User07?

I""*‘ Do you want to delete the item(s)?

~ Folder0l

N

The selected folders are deleted.
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Hl Renaming user boxes and folders

This operation allows you to rename the user boxes and folders.
P.50 “Renaming user boxes”
P.52 “Renaming folders”

Tip

When the box has been protected with a password, users must enter it to rename the box or folders. Users with an
administrator privilege can rename all user boxes and folders by using their password.

You can rename folders in the public box, but cannot rename the public box itself.

0 Renaming user boxes

Do not turn off the power of the equipment when changing the box name. All folders and documents in the box will be
lost if the power is turned off while the system is saving a new name.

Tip
Users can rename user boxes from the control panel. For instructions on how to rename user boxes from the control

panel, see the following page:
P.29 “Editing user boxes”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the user box that you want to rename.

(¢ Electronic Filing
File Edit View Layout

Document & eFiling @ items)

18 e-Filing
[ A bublic Bog
57 001 UserD1
g 002 UserDz
&f 003 UserD3 @
50 004 UserD4
&f 005 UserDs

0 006 Userds
Ea 007 UserO?

[ rublic Box [[loo1 usero1

If you select a user box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber oot

Box Marme : Userl1

Box Password asssss

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Click the [File] menu and select [Rename].

Electronic Filing

%

Document

{8 e-Filing
£ (¥ Public

Box

E & 001 Usernl
[l &5 Folderol
ga 002 User02
0 003 Userds
ga 004 User04
g 005 Userns
ga 006 UserO&
&g 007 Usern?

New Folder
Open

Archive |".\ument
Upload Archiwed Document

Test Print
Print Document
Properties

Send Email

[CIFoldero1

The Rename Box window appears.

Make sure that no folder or document is selected in the Contents frame. If a folder or document is selected, it

will be renamed instead of the selected box.

5 Edit the name in the [Name] box and click [OK].

Rename Box

Mame :

Gaevm

)

The confirmation dialog box appears.

Box names can consist of any ASCII characters except\/<>"% & =";:*?|#[]{}. Do not use a space or
period at the beginning or end of the name. The maximum size of a box name is 32 characters.

@ Click [OK].

Message from webpage ===
@ Do you want to rename the item?
. ©
r‘“

The selected box is renamed.
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0 Renaming folders

Do not turn off the power of the equipment when changing the folder name. All documents in the folder will be lost if the
power is turned off while the system is saving a new name.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box containing the folder you want to rename.

(¢ Electronic Filing
File Edit View Layout

Document B e Filing @ terms)

{8 e-Filing

g Public Box
Eﬁ 001 User0l
&g 002 UserDz
Eﬁ 003 Userd3 @ @
&0 004 UserD4
Eﬁ 005 Userds
50 006 Userds
Eﬁ 007 Userd?

[Crublic Box [[loo1 usero1

3 If you select a box that is protected with a password, the Password Authentication
window appears. In this case, enter the password in the [Box Password] box and click
[OK].

Password Authentication

Box Murmnber : on1

Box Mame Userl1

Box Password © LTI

All folders and documents in the box are displayed in the Contents frame.

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Select the check box of the folder that you want to rename and select [Rename] from
the [File] menu.

(@ Electronic Filing
Document
New Folder
{8 e-Filing Open
E Mg Public Box
E & 001 Usernl Archive [ \1
5 £ Folderol Upload Ar 8ﬂ:um=m
A 002 User0z e
&g 003 Userds Print Document.

& 004 User0s
g 005 Userds
& 006 User0&
&g 007 Usern? Send Email

Properties

The Rename Folder window appears.

* Do not select several folders at the same time. You can only rename one folder at a time.

* You can also rename a folder by selecting the folder in the Document frame, clicking on the [File] menu and
selecting [Rename]. In that case, make sure that no document is selected in the Contents frame. If a
document is selected, it will be renamed instead of the selected folder.

5 Edit the name in the [Name] box and click [OK].

Rename Folder

Mame ‘ Falded1 ’

The confirmation dialog box appears.

Folder names can consist of any ASCII character except\/<>"% &=";:*?|#[]{}. Do not use a space or
period at the beginning or end of the name. The maximum size of a folder name is 64 characters.
G Click [OK].
Message from webpage

@ Do you want to rename the item?
v‘\\

The selected folder is renamed.
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H Modifying and displaying user box and folder properties

This operation allows you to display and modify the properties of user boxes such as the box password and maintenance
period to automatically delete documents, and Email notification settings. This operation also allows you to view and
confirm the folder properties.
P.54 “Modifying box properties”
P.57 “Displaying folder properties”

Tip

When the box has been protected with a password, you must enter it to modify the box properties. Users with an
administrator privilege can modify all user box properties and public box properties by using their password.

0 Modifying box properties

* If you want to modify the public box properties, you must first log in as the system administrator.
* You cannot modify the password of a box that any user is currently accessing.

Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the user box whose properties you want to display and

edit.
(¢ Electronic Filing
File Edit View Layout
Document B e Filing @ terms)
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Bax Murnber : on1

Box Marme : Userl1

Box Password © LTI

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 HOW TO MANAGE USER BOXES/FOLDERS

4 Click the [File] menu and select [Properties].

(‘@ Electronic Filing
File Edit View

Document
New Folder
{8 e-Filing Open
E Mg Public Box Rename
E & 001 Usernl Archive Document
5 &9 Folderol Upload Archived Document
& 002 User02 i
0 003 Userds Print Document.

& 004 User0s
0 005 Userns
& 006 User0& AL
&g 007 Usern? Send Email

[CIFoldero1

The Box Properties window appears. In the Box Properties window, you can see the box properties.

5 If you want to edit the box properties, click [Change Properties].

Box Properties

Ei 001 Usert

Contains. OFile(sy 1 Folder(s)

Preservation Period for Documents © -

Email Address for Molification

Created 2011.051009:03:22
Modified 2011.05.1009:03:22

[ 0K ] [ Change Properties %

The Change Box Properties window is displayed.

Tip

If you do not need to change the box properties, press [OK] on the above screen to complete the operation.
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6 Specify the following items as required and press [Save].

Change Box Properties

001 Userd?

[T Change Box Password
Old Password
MNew Password

Confirm New Password

Change Preservation Period for Docurments inside Box
[7] Delete dacument automatically

Preservation Period for Cocuments days
e-Filing Motification Events
[7] send Email when an errar occurs
[T 2end Email when job is completed

Advance automatic delete notification

emai aaures< |

Advanced notification is sent hefare the date of file deletion. -[3] day(s) notice.

Change Box Password — Select this check box to edit the box password. When you select this check box, enter

the password in the [Old Password], [New Password], and [Confirm New Password] boxes.

¢ Old Password — Enter the current box password. This option is enabled only when you select the [Change
Box Password] check box.

* New Password — Enter the new box password. This option is enabled only when you select the [Change Box
Password] check box.

* Confirm New Password — Enter the new box password again. This option is enabled only when you select
the [Change Box Password] check box.

Tip
If you forget the old password, you can enter the administrator password in the [Old Password] box instead of it.

Delete document automatically — Select this check box to automatically delete the documents in this box. When

you select this check box, enter the number of days in the [Preservation Period for Documents] box.

* Preservation Period for Documents — Enter the number of days that the documents will be preserved. The
documents will be deleted after the specified number of days have passed. If you set this period to 1 day, the
document will be deleted automatically 24 hours later.

If a document is automatically deleted by the [Delete document automatically] function, the delete history is not
stored in the log.
For details of the logs, refer to the TopAccess Guide.

Send Email when an error occurs — Select this check box to send a notification message to the specified Email
address when an error occurs. When you select this check box, enter the Email address in the [Email Address]
box.

Send Email when job is completed — Select this check box to send a notification message to the specified Email
address when a job is complete. When you select this check box, enter the Email address in the [Email Address]
box.
Advance automatic delete notification — Select this check box to enable an Email notification message to be
sent to the specified Email address 3 days before it automatically deletes the documents. When you select this
check box, enter the Email address in the [Email Address] box.

¢ Email Address — Enter the Email address to which the notification will be sent.
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Tip
When the options “Send Email when an error occurs” and “Send Email when job is completed” are enabled,
you are notified of whether or not the following e-Filing operations are successfully completed.
- Scan to e-Filing
- Copy to e-Filing
- Print to e-Filing
- Fax/Internet Fax Received Forward to e-Filing
- e-Filing to Print
- e-Filing to Email

An administrator can configure the e-Filing notification setting in the TopAccess [Administration] tab -
Maintenance - Notification page. For more information, refer to the TopAccess Guide.

7 Click [OK] to close the Box Properties window.

Box Properties

001 Userd?

Contains, O File(sy 1 Folder(s)

Preseration Period for Documents © - -

Ermail Address for Motification

Created 2011.051008:03:22

Modified : 2011.05.1003:04:43
OK[ Change Properies

U Displaying folder properties
You can only view and confirm the folder properties. No operation to modify the folder properties is available.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box containing the folder whose properties you want

to display.
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Document B e-Filing & items)
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber ont

Box Mame User1

Box Password : ssssss

All folders and documents in the box are displayed in the Contents frame.

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

Select the check box of the folder with the properties that you want to view and select
[Properties] from the [File] menu.

(g Electronic Filing

Document
New Folder
18 e-Filing Open
= g Public Box fename
= 49 001 User0dl Archive Document
(=) Foldero1 Upload Archived Document.
&0 002 Usernz F—
&f 003 User03 Print Document.

&0 004 Usern4
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The Folder Properties window appears. In the Folder Properties window, you can view the folder properties.

* Do not select several folders at the same time. You can only view the properties of one folder at a time.

* Users can also display the properties of a folder by selecting the folder in the Document frame, clicking on
the [File] menu and selecting [Properties]. In that case, make sure that no document is selected in the
Contents frame. If a document is selected, its properties are displayed instead of the selected folder.

5 Click [OK] to close the Folder Properties window.

Folder Properties

D Faldernt

Location : e-FilingMJserntFalderol
Contains 0 Filets)

Created 2011.051009:03:38
Modified 2011.051009.03:38

A

The following information is displayed in the Folder Properties window:
Location — Displays the directory where the folder is located.
Contains — Displays the number of files the folder contains.

Created — Displays the date and time the folder was created.
Modified — Displays the date and time the folder was last modified.

58

Managing User Boxes and Folders



MANAGING DOCUMENTS

This chapter provides instructions on how to manage documents by using the e-Filing web utility.
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How To Manage Documents

The e-Filing web utility allows you to manage the documents stored in the e-Filing system.
This section explains the following operations:

P.60 “Displaying documents”

P.61 “Renaming documents”

P.63 “Deleting documents”

P.64 “Printing documents”

P.70 “Storing documents”

P.73 “Archiving documents”

P.78 “Sending Email”

M Displaying documents

Two ways are available to view your document image files. The document view options are:

* Thumbnail view displays several files from a selected box, folder or several pages of the selected document. This is
the default view. Use it to manage documents and files.

P.60 “Using the thumbnail view”

List view displays file names and properties in a tabular format. Use it to manage boxes and folders containing a large
number of files.

P.61 “Using the list view”

O Using the thumbnail view

This is the default view, unless you choose a different one. It displays a small image of each file or folder (if you highlight a
box or folder in the left frame) or each page (if you highlight a document in the left frame) with the file name or page
number and a check box. Click the check boxes to select the files or pages that you want to move, copy, delete or print.
To return to the thumbnail view, go to the [View] menu and select [Thumbnail].
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0 Using the list view

This view displays boxes, folders, or file names with the properties and check boxes in a list format. You may find it more
convenient than the thumbnail view for managing boxes and folders that contain a large number of files. Click the check
boxes to select a single file or multiple files that you want to move, copy, delete or print.

To display your files by the list view, go to the [View] menu and select [List].
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l Renaming documents

This operation allows you to rename the documents.

Do not turn off the power of the equipment when changing the document name. The document will be lost if the power
is turned off while the system is saving a new name.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document you want to

rename.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber ool

Box Marme Userd1

Box Password LLTTLT)

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

Select the check box of the document that you want to rename and select [Rename]
from the [File] menu.

(¥ Electronic Filing
e e wvew oo |

Document
{8 e-Filing
[ Public Box
E & 001 Usernl
(] Folderdl
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[FYelEe SRS R} Print Document:
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& 004 User04
g 005 Userds Send Email
& 006 User0s
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Test Print

Properties

[CIFoldero1

4 DOC110510
\ [Scan]

The Rename Document window opens.

Tip
Users can also rename a document by selecting the document in the Document frame, clicking on the [File]

menu and selecting [Rename]. In that case, even if you select the check boxes of pages in the Contents frame,
e-Filing will only rename the selected document in the Document frame.

5 Enter the document name in the [Name] box and click [OK].

Rename Document

Mame: DoC110510

The confirmation dialog box appears.

Document names can consist of any ASCII characters except\/<>"% &=";:*?|#[]{}. Do not use a space
or period at the beginning or end of the name. The maximum size of a document name is 64 characters.
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@ Click [OK].

Message from webpage \EI

|9w Do you want ta rename the item?

[4\)

The document is renamed.

H Deleting documents
This operation allows you to delete documents from the box or folder.

Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the documents you want to

delete.
(9 Electronic Filing
Document B e-Filing & items)
18 e-Filing

=/ [-p Public Box
5001 UserDl
Ea 002 User02
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Ea 004 User04
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber on1

Box Marme User01

Box Password [LIITT]

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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Select the check boxes of the documents that you want to delete and select [Delete]
from the [Edit] menu.
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Cut
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The confirmation dialog box appears.

Users can also delete a document by selecting it in the Document frame, clicking on the [Edit] menu and
selecting [Delete]. In that case, make sure that no pages are selected in the Contents frame. If any pages are
selected, the alert message will be displayed because pages cannot be deleted in the View mode.

5 Click [OK].

Message from webpage

‘."""‘I Do you want to delete the item(s)?

© DOCLIOSI0

Cancel

The documents are deleted.

M Printing documents

You can print documents and images from boxes and folders in the e-Filing web utility. The following two ways are
available to print them:

P.64 “Printing an entire document”

P.67 “Selecting test print”

O Printing an entire document
This operation allows you to print the entire document with various print options selected.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document that you want
to print.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber ool

Box Marme Userd1

Box Password ‘ LLTTLT) ,

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.
* The password input is displayed in the blank symbols.
Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

Select the check box of the document that you want to print and select [Print
Document] from the [File] menu.

(g Electronic Filing
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The Print window appears.

You can also print a document by selecting it in the Document frame and [Print Document] on the [File] menu.
However, you cannot print individual pages even if you select the check boxes of the pages displayed in the
Contents frame.
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5 Select the following print options as required and click [Print].

Print
Duplex: Mone - jJ Coverf/Sheet Insertion:
Humnber of Copies: 1 [7] Use Front Cover
@ Sort Copies Source: Auto Select
O Group Copies JJJJJJ Print Style: Do not print on page
Ratate Sort Copies : : [F] Use Back Cover
Paper Type: Plain - Source; Auto Select
Print Style: Do not print on page
Departrent Code: _ [7] Insert Pages
Paper Source: Auto Select - Saurce: Auto Select
Destination: Stacker - Print Style: Do not print on page
Staple: Mone JJ Pages: _
Binding: Mone JJ [T Interleave Pages
Hole Punch: MHone Source; Auto Select
Page Number: Duplicate
Position: Mone - Paper Type (Insert): |Plain
Initial Pags: R [ scheduled Print
‘fear Month Date Time
Time Stamp: Date & Time : 011 5 0 .
Pasition: Mone -
Image Shift:
Pasition: Mane -
Shift Margin
Front: a
Back: a

Duplex — Select whether you want the document printed on both sides of the paper. When you want to print the
document on both sides, select the Book option to print vertically in the same direction to be bound along the
vertical side of the paper so that the pages can be turned over right and left, or the Tablet option to print with a
vertical reversal to be bound along the horizontal side of the paper so that the pages can be turned over up and
down.

Number of Copies — Enter the number of copies to be printed.

The selectable range of the number of copies, 1 copy to 999 copies.

Sort Copies — Select this option to output the document separately for each copy.
Group Copies — Select this option to output the document separately for each page.
Rotate Sort Copies — Select this option to output the document by changing the output orientation of each
copy. This option is enabled only when you enter more than one copy in the [Number of Copies] box. When this
option is selected, the Destination option is automatically set to the inner finisher. To perform the Rotate Sort
Copies, the portrait and landscape paper must be set in different trays.
Paper Type — Select the type of paper desired.
Department Code — Enter the 1 to 63-digit department code, if required. You must enter the department code to
print a document if the department code is enabled on the equipment.
Paper Source — Select the paper feed source. Select a paper source that correlates with the printing size.
Destination — Select the tray to which the document will be output.
Staple — Select whether the document is to be stapled or not. When you want to staple the document, select how
it will be done.

If you enable the Staple option after enabling the Interleave Pages option, the latter will be automatically
disabled.

Binding — Select this option to output the document folded or stapled at the center. You can set how the
document is output.

* Center Fold — The document is folded at the center.

* Saddle Stitch — The document is double-stapled and folded at the center.

“Binding” is enabled only when the optional Saddle Stitch Finisher is installed.
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Hole Punch — Select whether the document is to be hole-punched or not. When you want to hole-punch the
document, select how it will be done.

Page Number - Position — Select whether the page numbers are to be printed on the pages. When you want to
print the page numbers, select where it will be done.

Page Number - Initial Page — Enter the first number that applies to the first page of the document. When the
Cover/Sheet Insertion - Use Front Cover option is enabled, the front cover is counted as the first page, and the first
page of the document is counted at the second page.

Time Stamp - Position — Select whether the print time is printed on each page or not. When you want to print the
time stamp, select where you want it to be done.

Image Shift - Position — Select whether the printed images are to be shifted or not. When you want to shift the
printed images, select it to be done.

Shift Margin - Front — Select the width of the margin that is to be added to the side when the printed images are
shifted.

Shift Margin - Back — Select the width of the margin that is to be added to the opposite side when the printed

images are shifted. H
Cover/Sheet Insertion - Use Front Cover — This option sets front cover printing which allows you to insert or
print a cover on a sheet fed from a different tray than the Paper Source option. To enable front cover printing, select
the check box and specify the location from where the cover sheet is to be fed and the print style to be used.
Cover/Sheet Insertion - Use Back Cover — This option sets back cover printing which allows you to insert or
print a cover on a sheet fed from a different tray than the Paper Source option. To enable back cover printing,
select the check box and specify the location from where the cover sheet is to be fed and the print style to be used.
Cover/Sheet Insertion - Insert Pages — This option sets sheet insertion printing which allows you to insert a
sheet between pages, or print a specific page on a sheet fed from a tray other than the Paper Source option. This
option is useful when you want to insert a blank sheet between chapters, or when you want to print chapter cover
pages on different paper. To enable sheet insertion printing, select the check box and specify the location from
where the inserted sheets are to be fed and the print style to be used. Then enter the page numbers you want to
insert, separating them with commas if multiple pages are specified, in the [Pages] box.

Cover/Sheet Insertion - Interleave Pages — This option sets the interleaving page feature that is useful when
you want to insert paper of a different type (or from another source) between every page of your print job. For
example, you could use this option to insert blank, colored sheets between overhead transparencies. To enable
interleaving pages, select the check box and specify the location from where sheets are to be fed. Also, select the
[Duplicate] check box if you want to print the previous page images on the inserted sheet.

If you enable the Interleave Pages option after enabling the Staple option, the latter will be automatically
disabled.

Paper Type (Insert) — When you select the MPT option for the paper source of either the Use Front Cover, User
Back Cover, Insert Pages, or Interleave Pages option, select the paper type for the paper fed from the MPT.
Tip

When both the user management and department management settings are enabled, the quotas that are
allowed for the department and user will be displayed in the upper right-hand area of the page.

Scheduled Print — Select this option to print a job at a future date and time. When this option is selected, set the
date and time to print the job in the [Date & Time] box.
Tips

* Clicking [Print] prints the document, and the print result window is displayed.
* Clicking [Cancel] closes the Print window without printing.
* Clicking [Reset] restores the default print properties settings.

6 Click [Close] to return to the [Documents] tab page.

When you want to cancel a job before printing is complete, access TopAccess, click the [Job Status] tab >
[Print], select the job and press [Delete].

0 Selecting test print

This operation allows you to simply print a copy of a document by using the default print properties settings.
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1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document that you want

to print.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber o1

Box Mame Userd1

Box Password ‘ sassss ,

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to print and select [Test Print] from
the [File] menu.

(g Electronic Filing

Document
New Folder
18 e-Filing Open
[ Public Box Hename
& /001 User0l Archive Document
0] Falderol Upload Archived Document.
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Properties

110510
[Scan]

The Test Print window appears.

You can also perform test printing by selecting a document in the Document frame and then selecting [Test
Print] on the [File] menu. However, you cannot print individual pages, even if you select the check boxes of the
pages displayed in the Contents frame.
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5 Select whether to print all pages of the document or only specified pages and click
[Print].

Test Print

@ Al Pages Department Code

51 -3 Pages T

All Pages — Select this option to print all pages of the document.
[first page number] - [last page number] Pages — Select this option to specify the pages to be printed. When
this option is selected, enter the numbers of first page and last page to be printed in each box.

Department Code — Enter a department code. This must be entered only when the department code is enabled H
on the equipment.

Tips

* When both the user management and department management settings are enabled, the quotas that are
allowed for the department and user will be displayed in the upper right-hand area of the page.

* Clicking [Print] prints one copy of the document and the print result window is displayed.

* Clicking [Cancel] closes the Test Print window without printing.

6 Click [Close] to return to the [Documents] tab page.

When you want to cancel a job before printing is complete, access TopAccess, click the [Job Status] tab >
[Print], select the job and press [Delete].
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H Storing documents

From an application that runs under the Windows operating system, you can send a document as a print job to e-Filing

with the printer driver.

You can store your documents in the public box or in a user box.

P.70 “Saving a print job in the public box”
P.71 “Saving a print job in a user box”

To use this function, the printing function is required.

When you store a document in e-Filing by using the printer driver, the printed image (not the original document in your

computer) will be stored in e-Filing.

Tips

* For more information about the printer driver, refer to the Printing Guide.

For a detailed explanation of the public box and user box, see the following page:
P.6 “e-Filing Features”

You can also store a scanned document in e-Filing by using the control panel. For details, see the following page:
P.17 “Storing Documents”

U Saving a print job in the public box

1
2

Open the document that you want to store in the box.

Click the [File] menu and select [Print] in your application.
The [Print] dialog box appears.

Select the printer driver of the equipment to be used and click [Preferences].
The [Printing Preferences] dialog box appears.

Tip

The procedure for displaying the [Printing Preferences] dialog box for the printer driver may be different

depending on the application that you are using. Refer to your application manual about displaying the [Printing
Preferences] dialog box.

Select the print job type on the [Basic] tab.
1) Select [Store to e-Filing] in the [Print Job] box.
2) Select other print options as required.
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5 Select [Public Box] to save the print job and click [OK].

Store to e-Filing ==
Store to; Password
000 Public Br &
Box Folder 1
[ Print
 N—T— [ Gancal

Tips

* If you print a job as well as saving it in the public box, select the [Print] check box.
* If you want to save a print job in a specified folder, enter its name in the [Box Folder] box.
To save data in an existing folder, enter its folder name in the [Box Folder] box.
To create a new folder and save data in it, enter the new folder name in the [Box Folder] box.

Click [OK] or [Print] to save the print job.

The print job is saved in the public box.

U Saving a print job in a user box

1 Open the document that you want to store in the box.

2 Click the [File] menu and select [Print] in your application.
The [Print] dialog box appears.

3 Select the printer driver of the equipment to be used and click [Preferences].
The [Printing Preferences] dialog box appears.

Tip

The procedure for displaying the [Printing Preferences] dialog box for the printer driver may be different
depending on the application that you are using. Refer to your application manual about displaying the [Printing
Preferences] dialog box.

4 Select the print job type on the [Basic] tab.
1) Select [Store to e-Filing] in the [Print Job] box.
2) Select other print options as required.

3) Click [OK].
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5 Select a user box to save the print job.
1) Select the desired user box number from the [Store to] box.
2) Enter the password for the user box in the [Password] box.
3) If you print a job as well as saving it in the user box, select the [Print] check box.
4)

Click [OK].
Store to e-Filing ==
Store to: Password:
secese
Box Folder %
Folder 1 1 2
Print
3 (i [ Gancal |
| 4
Tip

If you want to save a print job in a specified folder, enter its name in the [Box Folder] box.
To save data in an existing folder, enter its folder name in the [Box Folder] box.
To create a new folder and save data in it, enter the new folder name in the [Box Folder] box.

If the Enable SNMP Communication option is enabled on the [Configuration] tab, only the user boxes that have
been set up will be displayed in the drop-down list box.

6 Click [OK] or [Print] to save the print job.

The print job is saved in the specified user box.
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M Archiving documents

The e-Filing web utility allows you to archive the documents stored in e-Filing and download the archived files to your
computer. These files can also be uploaded from your computer to e-Filing in the equipment, or other equipment of the
same OKI MFP Series.

P.73 “Downloading an archived document”

P.76 “Uploading archived documents”

The archive files are compatible with the same series of the OKI MFP, not with another series. For example, archived
files downloaded from the ES9465 MFP can be uploaded in an OKI MFP in the ES9475 MFP series, not in the ES9455
MFP.

U Downloading an archived document

You can archive the documents in the box and download it to your computer. Use this feature to create a back-up file of
your documents in e-Filing.

The following procedure describes an example of how to download an archived document when using Microsoft Internet
Explorer.

* The archived file contains all the documents you have specified to the archive, but you cannot open the documents
on your computer.

* You can create an archived file that contains multiple documents in the same folder or the same box.

* You cannot create an archived file that contains more than 2 GB of data.

* Do not close the main window and child window by clicking [X]. If you do, downloading the archived documents
becomes impossible. If you close the window by clicking [X] by mistake, turn the power to the equipment off and
then on again.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document that you want

to archive.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber ool

Box Marme Userd1

Box Password ‘ [LTTLT) ,

» If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

Select the check box of the document that you want to archive and select [Archive
Document] from the [File] menu.

(@ Electronic Filing

Document
New Folder
18 e-Filing Open
[ Public Box fename

= 49 001 User0dl
() Foldero1
| DOC110510 e
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Upload Archived D(\'ﬂ:ﬂl

Properties

[FIFalderol
110510
[Scan]

The confirmation dialog box appears.

Users can also archive a document by selecting the document in the Document frame, clicking on the [File]
menu and selecting [Archive Document]. However, you cannot archive individual pages, even if you select the
check boxes of the pages displayed in the Contents frame.

5 Click [OK] to start archiving the document.

Message from webpage

'@' Do you want ta archive the document?

&Y This process may take some time.
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The Archive Document window appears. During archiving, you can quit the process by

clicking [Cancel].

Archive Document

This process may take some time
Please wait while the document is compressed and a downloadable archive file is created

A5 %

Cancel

When archiving the document has been completed, “Your document has been archived successfully” is displayed.

Do not perform any operation while the e-Filing web utility is running busy.

Archive Document

our docurnent has been archived suceessiully.

Please click the link below.

Yau can now dawnload the archived file onta your system.

The link will launch a file download dialog allowing you to select a name and path for the zip file
FileName: 20110510_15442.zip

Crealed: 05102011 09:40:42
Size (KB): 21 MB

The [File Download] dialog box appears.

8 Click [Save].

File Download ==

Do you want to open or save this file?

Name: 20110510_15442.2ip
i Type: Compressed zipped) Falder, 21,9MB
From: 157.69.73.250

Open | [ Save | [ Cancel

[¥] &lways ask before opening this tpe of file

0 '\ 1 “while files from the Internet can be useful, some files can potentially
\a harm your computer. [ you da not trust the source, do not opsn or
. save this file. What's the risk?

The [Save As] dialog box appears.

7 Click the file name link to download the archived file.

I8 Dawnloads
User001

? System Folder

a

Libraries :
e A Camputer
O 5 oo polder

™ Computer

- N—
€ Metwork L System Folder

i Drivers
i

] Recent Places

File folder

File name: 20110510 15442

Save As =
@@v\!mshmp v [ 43| [ search Desktap r
Organize v Newfolder B~ @

7 Favorites XS | braries
B Desktop || System Folder

m

Save as type: |Compressed (zipped) Folder

“ Hide Folders

This starts downloading the file.

9 Locate the folder where you want the archived file saved and click [Save].
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10 Click [Close].

Archive Document
Your document has been archived successfully.

Please clickthe link below.

*¥ou can now download the archived file onto your system

The linkwill launch a file download dialog allowing you to select a name and path for the zip file
File Name: 20110510 15442 zig

Created 05:10:2011 08:40:42

Size (KB): 21 WB

0 Uploading archived documents

If you have an archived file that has been downloaded from the equipment to your computer, you can upload it to e-Filing.
When you upload the archived file, the file is automatically extracted and documents will be created in the box specified.

* If the same name document already exists in the box, the extracted document will be renamed by adding a 3-digit
number to the original name.

* Do not close the main window and child window by clicking [X]. If you do, uploading the archived documents
becomes impossible. If you close the window by clicking [X] by mistake, turn the power to the equipment off and
then on again.

Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder where you want to upload the archived

documents.
(9 Electronic Filing
File Edit View Layout
Document B eFiling @ items)
{83 eFiling

=/ [ Public Box
5@ 001 UserDl
Ea 002 User02
50 003 UserD3 63
Ea 004 User04
&0 005 UserDs
Ea 006 UserO6
5 007 Userd?

[FlPublic Bax [Floo1 userol

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber onz

Box Mame User02

Box Password sassss

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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5 MANAGING DOCUMENTS

4 Select [Upload Archived Document] from the [File] menu.

(‘@ Electronic Filing
File Edit View

Document
New Folder
{8 e-Filing Open
[ Public Box Rename
& 001 User01 Archive Document
= & 002 Usern2
) Folderoz e k
&0 003 Userds Print Document.

& 004 Users
g 005 Userds
& 006 User0&
&g 007 Usern? Send Email

Properties

[IFolderoz

The Upload Archived Document window appears.

5 Click [Browse].

Upload Archived Document

[archived File : [ Browse [

The [Choose File] dialog box appears.
6 Select the archived file to be uploaded and click [Open].

@.\y b Archive » + [ 4 ||| Search Archive 2]

Organize »  New folder g~ O @

¢ Favorites 20110510_15442
B Desktop \p Compressed zipped) Folder
'l Downloads '

%] Recent Places

[ Libraries
M Computer

€ Netwark

File name: 20110510_15442 - |AlFiles () -

w2

This will return you to the Upload Archived Document window, and the folder path of the selected file will be
displayed in the [Archived File] box.

7 Click [OK].

Upload Archived Document

Wrehived File @ CUsers\Usel01\DesktoptArchivelz | Browse

LBk [ cancel |

A}

The confirmation dialog box appears.
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8 Click [OK] to start uploading the archived file.

IMessage fram webpage @

‘."' b Do you want to upload the archived file?
"' This process may take some time.

QK ,{ [ Cancel
Ia
A\

If you select an archived file unsupported in your model or a file other than an archived one, an error message
appears. In that case, select the correct archived file and try again.

The Upload Archive Document window shows the process of uploading. During the
uploading process, you can quit uploading by clicking [Cancel].

Upload Archived Document
This process may take some time

Please wait while the archived file is uploaded to the selected box.

When uploading the archived file has been completed, “Your document has been uploaded successfully” is
displayed.

Do not perform any operation while the e-Filing web utility is running busy.

10 Click [Close].

Upload Archived Document

Your document has heen uploaded successfully.

The documents are added to the selected box.

H Sending Email

You can send the selected documents as Emails from the e-Filing web utility.
When you perform this function, the equipment creates an Email with the selected documents as an attached file and
sends the Email directly from the equipment.

To use this function, the scanning function is required.

* To use the Send Email function, the Email configuration of the equipment needs to be set by the network
administrator.

* When using a multifunctional digital color system (color MFP), you can send e-Filing documents as Emails only
when they have been saved under the conditions noted below. Check the document properties before sending the
documents.

- Documents which were saved with the copy function of the equipment in the black - TEXT/PHOTO or black -
TEXT mode

- Documents which were saved with the scanning function of the equipment

- Documents which were saved with the received fax/Internet Fax transferred function
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Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document that you want
to send as an Email.

(¢ Electronic Filing
e _ow  wew oow |
Document B e Filing @ tems)

5@ 001 UserDl

Ea 002 User02
50 003 UserD3 63 ﬁa
Ea 004 User04 ﬂ

0 005 UserDs
Ea 006 UserO6

&g 007 Userd?
[FlPublic Bax [Flo01 userol

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber o1

Box Mame Userd1

Box Password ‘ sassss ,

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to send as an Email and select
[Send Email] from the [File] menu.

(@ Electronic Filing

Document
New Folder
18 e-Filing Open
(5 Public Box femame
= 49 001 User0dl Archive Document
7 Folderol Upload Archived Document
| DOC110510 TestPrimt

[ Doc110510-001 | EPERIETE
0 002 Usernz
& 003 User0a
&0 004 Usern4
#f 005 User0s
0 006 Userds
& 007 User0?

Properties
110510
[Scan]

The Send Email page is displayed.

Tips

* Users can also send a document as an Email by selecting the document in the Document frame, clicking on
the [File] menu and selecting [Send Email].

* Users can also send up to 100 individual pages or documents by selecting the check boxes displayed in the
Contents frame.
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5 Specify the following items as required and click [Send].

Send Email
[ To: Destination Setting ]
\To- Destination | single \
CC: Destination Setting
22 Destination [ |
[ BCC: Destination Setting ]
[BEC: Destination [ |
Email Setting
*Required
@ Send data from (Device name) (Box Info )
Subject ol
[ et the dete and time tothe subject
*From Address Uze1@example.com
Fram Mame User
Body
File Format PDFMulti) =
Encryption
User Passwol] |eeeeeesessssssssss Ritype Passwind jssssssssssssssssss
Master Password |sssssssssssssssssa Retype Password |ssssssssssssssssss
Encryption Level  128-bit AES ~
D Autharity
[#] Printing
[¥] Change of Documents
[¥] Content Copying or Extraction
[¥] Content Extraction for accessibility
@ Do MMODMMDD is a date)
File: Mame (@ Original Document Name
Fragmert Message Size Mo Fragrmentation +
\

[TO: Destination Setting] — Click this button to specify the destination. When you click this button, the Recipient

List page appears. For instructions on how to specify the destination, see the following section:

P.82 “Destination setting”

[CC: Destination Setting] — Click this button to specify the CC destination.

[BCC: Destination Setting] — Click this button to specify the BCC destination.

Subject — This option sets the subject of the Email documents. Select [Send data from (Device name) (Box Info.)]

set by default, or enter the desired subject in the box. When you want to add the date and time to the subject,

select the [Add the date and time to the subject] check box.

From Address — Enter the Email address of the sender. When the recipient replies, the message will be sent to

this Email address.

From Name — Enter the sender’s name of the Email document.

Body — Enter the body message of the Email document. You can enter up to 1000 characters (including spaces).

File Format — Select the file format to which the received document will be converted.

* TIFF (Multi) — Select this option to save the scanned images as a multi-page TIFF file.

* TIFF (Single) — Select this option to save the scanned images separately as single-page TIFF files.

* PDF (Multi) — Select this option to save the scanned images as a multi-page PDF file.

* PDF (Single) — Select this option to save the scanned images separately as single-page PDF files.

* XPS (Multi) — Select this option to save the scanned images as a multi-page XPS file.

* XPS (Single) — Select this option to save the scanned images separately as single-page XPS files.

* JPEG — Select this option to save the scanned images as JPEG files. This option is selectable only when you
have scanned the images with either [FULL COLOR] or [GRAY SCALE].

» If the forced encryption setting is enabled, only [PDF (Multi)] and [PDF (Single)] are selectable for the file
format. For the forced encryption function, refer to the MFP Management Guide.

* Files saved in the XPS format can be used in Windows Vista, Windows 7, and Windows Server 2008, or
Windows XP SP2, Windows Server 2003 SP2 or later versions with Net Framework 3.0 installed.

Encryption — Set this option for encrypting PDF files if you have selected [PDF (Multi)] or [PDF (Single)] as the
file format setting.

* Encryption — Select this check box if you want to encrypt PDF files.

* User Password — Enter a password for opening encrypted PDF files.
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* Master Password — Enter a password for changing the encryption PDF setting.

Tips

» |f the forced encryption setting is enabled, you cannot clear the [Encryption] check box. For the forced
encryption function, refer to the MFP Management Guide.

* The user password and the master password are not set at the factory shipment. If the master password is
to be set, ask your network administrator.

* A password must be entered in one-byte alphanumeric characters. The minimum and maximum numbers of
characters allowed are 1 and 32.

¢ The user password must differ from the master password.

* These passwords can be re-entered only by an authorized user. Users cannot change the settings of the
[Encryption Level] box and the [Authority] box noted below if they are not authorized to change the master
password. Ask the administrator about resetting these passwords.

* For details of the encryption setting, refer to the MFP Management Guide.

* Encryption Level — Select the desired encryption level.
- 40-bit RC4 — Select this option to set an encryption level to the one compatible with Acrobat 3.0, PDF
V1.1.
- 128-bit RC4 — Select this option to set an encryption level to the one compatible with Acrobat 5.0, PDF
V1.4.
- 128-bit AES — Select this option to set an encryption level to the one compatible with Acrobat 7.0, PDF
V1.6.
* Authority — Select the check box of the desired type for the encrypt PDF authority.
- Printing
- Change of Documents
- Content Copying or Extraction
- Content Extraction for accessibility
File Name — Select how the attached file will be named. Select [DocYYMMDD] to name it as described, select
[Original Document Name] to use the original document name, or you can enter the desired file name in the field.
Fragment Message Size — Select the size of the message fragmentation.
Department Code — Enter the department code if required.

6 Click [Close].

(¢ Electronic Filing

[Send Email

our document has been sent successfully.
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U Destination setting

On the Recipient List page, you can specify up to 400 destinations to send e-Filing documents as Email.
You can specify the recipients by entering the Email addresses manually, selecting the recipients from an address book,
selecting the recipient groups from an address book, or searching the LDAP server for recipients.

If [LDAP Authentication] is selected in [Authentication Type], you can choose only destinations that are registered in
the authenticated LDAP servers. For details of the LDAP Authentication option, refer to the TopAccess Guide.

P.82 “Entering recipients manually”

P.83 “Selecting recipients from an address book”
P.84 “Selecting groups from an address book”
P.85 “Searching the LDAP server for recipients”
P.86 “Removing contacts from the recipient list”

Entering recipients manually

Follow the steps below to manually add a recipient to the Recipient List.
1 Click [Destination Setting] to open the Recipient List page.
2 Click [New].

Recipient List

[ Cancal ][ Address Book H Address Group ][ Search ]
|i||vm V“ |Destmatmn

The Contact Property page is displayed.
3 Enter the Email address of the recipient in the [Destination] box and click [OK].

Contact Property

*Req 12

‘*Des‘tmalmn | UsedI2@example.com N

W1

The entered recipient is added to the Recipient List page.
4 Repeat steps 2 and 3 to add all the recipients as required.
Tip

You can remove contacts once added to the recipient list before saving the destination settings.
P.86 “Removing contacts from the recipient list”

5 Click [Savel].

Recipient List

[ Cancel ][ Address Book ][ Address Group ][ Search ]
] ame

|Deslinatmn

B | |UserDD2@Examp\e com ‘

The contacts are added as the destinations.
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Selecting recipients from an address book

Follow the steps below to select recipients from an address book.
1 Click [Destination Setting] to open the Recipient List page.
2 Click [Address Book].

Recipient List

[ Cancel ][ Address Book H Address Group ” Search ] Delete
|
|i||vName |Dest|nat‘ﬁgs

The Address Book page is displayed. H

3 Select the Email check boxes of the users you want to add and click [Add].

Address Book
Group Al Groups ~
A4
[Frail  [whame Ermail Address
B Lser(0 User(H 0@ example com
[F | [osercos User00g@example.com
[F | [osercos User00G@example.com
F || |oseraor Lser07 @example.cam
[ || [oseraoe User00B@example.cam
[ || |oseros UserD0S@example.com
Liser004 User004@example com
Liserons3 User003@sxample com
Liseron2 User002@example com
B User0ir User (01 @example com
’T’Jg ofthis page

The selected recipients are added to the Recipient List page.

Tips

» If you want to sort recipients into specific groups, select the desired group name in the [Group] box.
* You can remove contacts once added to the recipient list before saving the destination settings.
P.86 “Removing contacts from the recipient list”

4 Click [Save].

Recipient List

Saye [ Cancel ][ Address Book ][ Address Group ][ Search ]

| ame Destination

[F] |Userona LserD04@example com
[F] |Useronz LserD03@example com
[ |Userooz User002@example com

The contacts are added as the destinations.
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Selecting groups from an address book

Follow the steps below to select groups from an address book.

1 Click [Destination Setting] to open the Recipient List page.
2 Click [Address Group].
Recipient List

[ Cancel ]’ Address Book H Address Group ][ Search ]
N
|i||vm |Deslmatmn l’w

The Address Group page is displayed.

3 Select the group check boxes containing the desired recipients and click [Add].
Address Group

Groun |maup Mame
E Group0a

] | Broupnz
SroupDl

Mo p ofthis page

All recipients in the selected groups are added to the Recipient List page.
Tip

You can remove contacts once added to the recipient list before saving the destination settings.
P.86 “Removing contacts from the recipient list”

4 Click [Savel].

Recipient List

[ Cancal ][ Address Book H Address Group ” Search ]
K| arme

B |Gmupm

|Dest|natmn

foow

The contacts are added as the destinations.
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Searching the LDAP server for recipients

Follow the steps below to search the registered LDAP server for recipients.

Tip
To search the LDAP server for recipients, an administrator must set up the directory service by using TopAccess in the
administrator mode. For details, refer to the TopAccess Guide.

1 Click [Destination Setting] to open the Recipient List page.
2 Click [Search].

Recipient List

[ Cancel ][ Address Book H Address Group ]I Sean:hA]
|
|i||vName |De5|inat\un N

The Search Contact page is displayed.

Specify the search condition.

1) Select the directory service name that you want to search in the [Directory Service Name] box.
2) Enter the search terms in the fields that you want to search.
3) Click [Search].

Search Contact

Entera .k me or Email address to search for a contact

Directory Service Mame  LDAPOT hd
First Name %1

Last Name User
Ernall Address
Fax Number

Company

Department [

TopAccess will start searching the LDAP server for recipients, and the Search Address List page will display the
results.

Tips

* If you select the model name of the equipment in the [Directory Service Name] box, you can search the
address book of the equipment for recipients.

* TopAccess will search for the recipients that match the entries.

* Fill in at least one of the fields to perform a wild-card search.
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4 Select the Email check boxes of the users you want to add and click [Add].

Search Address List

= | <

ame company department Email Address
Usi 010 User01 0@example.com

Us¢ 00g User009g@example com

Us( 008 UserODa@example com

Us¢ 007 User007@example com

Us( 006 User00Gg@example com

Us{ 005 User00S@example.com

User04@example.com

Us{ 003 UserD03@example.com

Us{ 002 UserD02g@example.com

Us{ 001 User001 @example.com
orthis page

EEEEEEEEEE S

The selected recipients are added to the Recipient List page.

Tip

You can remove contacts once added to the recipient list before saving the destination settings.
P.86 “Removing contacts from the recipient list”

5 Click [Savel].

Recipient List

Save [ Cancal ][ Address Book H Address Group ” Search ]

K] ame Destination

[ |Usernod User004g@example com
[ |Usertoz User003@example com
[F] |Usernoz User002@example com

The contacts are added as the destinations.

Removing contacts from the recipient list

Select the check boxes of the contacts that you want to remove from the recipient list,
and click [Delete].

Recipient List

[ Cancel ]’ Address Book H Address Group ][ Search ] i Delete |
vhme Destination l’“

Use 004 UserD04@example.com

User003@example com

ElIEIEN=
=
Z
=

Use 002 User002@exampie com

The selected contacts are removed from the recipient list.
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EDITING DOCUMENTS

This chapter provides instructions on how to edit documents by using the e-Filing web utility.

About the Document Control Buttons............ccccciiiiiissrr e 88
Editing With Pages in YOUr DOCUMENLS .......c.coeueeiiiiiiiiirciececcsss e s s s e e s mmssssss s e e e e e e s nmms s nnnnees 89
Displaying document and page PrOPEITIES .........ocveiiiiiiiiiie ettt st e et et ees e nnreenneeeas 89
Copying pages from one document t0 @NOLNET ............cooiiiiiiii e s 90
Copying pages from a document 0 @ bOX OF TOIET.........ccoiuiiiiiie e e e 95
Deleting pages from @ OCUMENT...........oiiiiiiiiie et e st e e e et e e e e st e e e e e eestaeeeaeeassssseansseeeessnnssaeaaeannnns 99
Inserting a blank page into @ dOCUMENT.............uiiiii e e e e e e e e e e e e e s et eeeeaeeeens 101
Moving pages Within @ OCUMENT ...t et 104
Moving and Merging DOCUMENLS.........ccccoiimmeecmucinirir s rnecssssssss s e s eressmssssssss s s e e e e snnmmssssssssnnees 107
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About the Document Control Buttons

The e-Filing web utility allows you to make changes to your stored documents before you print them.

Three document control buttons are provided in the e-Filing web utility: [Edit], [Save], and [Cancel].

These buttons are displayed at the top of the Contents frame when you select a document in the Document frame. The
buttons displayed vary depending on the document status.

* [Edit] — Click this button to start editing the document. Only this button is displayed when you are in the View mode,
where the document status indicates “View”. When you click [Edit], the document status will be changed to “Editing”,
[Save] and [Cancel] appear instead of [Edit], and you can edit the document. If you click this button when the
document status indicates “In Use”, you cannot enter the Edit mode and the message “The Document is being used.
Please try again later” is displayed.

* [Save] — Click this button to save the document that you have edited. This button is displayed only when you are in
the Edit mode, where the document status indicates “Editing”. When you click this button, the document is saved and
returns to the View mode.

¢ [Cancel] — Click this button to return to the View mode without saving the document. This button is displayed only
when you are in the Edit mode, where the document status indicates “Editing”.

The document status is displayed to the left of these buttons. The document status indicates the following situations:
* In Use — This indicates that another user is currently editing the document.
* View — This indicates that the document is currently in the View mode, and you can only view the pages within the
document.
* Editing — This indicates that the document is currently in the Edit mode, and you can edit the document.

When you edit or delete a document that is shared by other users, make sure to refresh the display to see the latest
status of the document. If the two or more users try to edit or delete the document or the page at the same time, the
data may be damaged.
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Editing With Pages in Your Documents

The e-Filing web utility allows you to copy, move, delete and insert pages and change the order of pages in your
document.

) P.89 “Displaying document and page properties”

P.90 “Copying pages from one document to another”

P.95 “Copying pages from a document to a box or folder”

P.99 “Deleting pages from a document”

P.101 “Inserting a blank page into a document”

P.104 “Moving pages within a document”

H Displaying document and page properties

You can display the Document Properties and Page Properties windows that contain details of the document or page. To
display the Document Properties window, select the check box of the document and select [Properties] from the [File]
menu. To display the Page Properties window, select the check box of the page and select [Page Properties] from the
[File] menu.

The Document Properties window contains the following information:

Document Properties

r‘D DOC110410-001

Location e-Filing/MUser01/
Total Pageis) 3
Size 19 MB

Created : 2011.05.10 09:05:09
Modified 2011.0510 09:05:11
LastAccessed 2011.05.10 10:00:59

* Location
Displays the directory where the document is located.
* Total Page(s)
Displays the number of pages the document contains.
* Size
Displays the data size of the document.
e Created
Displays the date and time the document was created.
* Modified
Displays the date and time the document was last modified.
* Last Accessed
Displays the date and time the document was last accessed by any user.
* [OK]
Click this button to close the window.

The Page Properties window contains the following information:

Page Properties

E-l DOC110510-001 (1 73)

Format: Copy
Resolution B00x EOD
Image Size 4867 x 6922
Paper Size Ad

Size BY10 KB

* Format

Displays how the page is stored.
* Resolution

Displays the resolution of the page.
* Image Size

Displays the pixel size of the page.
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* Paper Size

Displays the paper size of the page.
* Size

Displays the data size of the page.
* [OK]

Click this button to close the window.

H Copying pages from one document to another
You can copy or cut pages from a document and insert them into another one.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document whose pages
you want to copy or cut.

(¥ Electronic Filing
File Edit. View Layout

Document B e Filing @ terms)

1B e-Filing

o g Public Box
5ﬁ 001 User0l
& 002 Userg2
5ﬁ 003 Userd3 @ @
&l D04 Userd4 ]
5ﬁ 005 Userds
&l D06 Userds
5ﬁ 007 Userd?

[ rublic Box [oo1 usernt

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber ont

Box Mame User1

BoxPassword: || ssssss

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 In the Document frame, select the document whose pages you want to copy or cut.

SEI tronic Filing Documents | Preferences Login
File Edit

Document B DOCHIOSI0001 {173) Status : View

{8 e-Filing
[ Public Box
E & 001 Userl
() Folderol

[& Doc110s10

|y DOC110510-001
& 002 User02 L
50 003 User03 I
&7 004 User04
g 005 Userds
& 006 User0f
&g 007 Usern?

[Flpages 2 [Flpages 2

The pages of the document are displayed in the Contents frame.

o

If you want to cut pages from the document, click [Edit] to enter the Edit mode. Clicking [Edit] changes the
document status from the View mode to the Edit mode so that you can cut pages from the document.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.

5 Select the check boxes of the pages that you want to copy or cut, and select [Copy] or
[Cut] from the [Edit] menu.
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* When you have cut pages from the document, proceed to the next step after the process is completed.
* When you have copied pages from the document, proceed to step 8 after the process is completed.

Do not perform any operation while the e-Filing web utility is busy.
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6 Click [Save] to save the document.
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2 items are cut.

The Save Document window appears.

7 Enter the document name in the [Document Name] box and click [Save].

Save

Y =

I |
DnnumenlNamﬁ)C‘HUSWUUm )

* If you rename the document, it will be saved as a new one. If you do not change the document name, the
original document will be overwritten.
The Contents frame displays the pages in the View mode.

* The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.

In the Document frame, select the box or folder containing the document into which
you want to insert the copied pages.
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The Document is saved,
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber onz2

Box Marme : Userl2

Box Password ‘ asssss ’

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

+ The password input is displayed in the blank symbols. n
Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

In the Document frame, select the document into which you want to insert the copied
pages, and click [Edit].
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The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.

11 Click the space between the pages where you want to insert the copied pages.
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The arrow indicators move to the space between the pages where you clicked.
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12 Click the [Edit] menu and select [Paste].
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The copied pages are inserted between the specified pages.

1 3 Click [Save].
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The Save Document window appears.

14 Enter the document name in the [Document Name] box and click [Save].

Save
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* If you rename the document, it will be saved as a new one. If you do not change the name, the original
document will be overwritten.
¢ The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.
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H Copying pages from a document to a box or folder
You can copy or cut pages from a document and save them in a box or folder as a new document.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document whose pages
you want to copy or cut.

(¥ Electronic Filing
File Edit. View Layout

Document & eFiling @ items)
¥ e-Filing
[ Public Box
& 001 Userdl
& 002 User2
&l 003 Userd3 63 ﬁa
& D04 User04 ]

&gl D05 Userds
éa 006 UserO6

&gl 007 Userd?
[FlPublic Bax 01 userol

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Bax Murnber : on1

Box Marme : Userl1

Box Password © LITLLT]

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 In the Document frame, select the document whose pages you want to copy or cut.
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The pages of the document are displayed in the Contents frame.

Tip
If you want to cut pages from the document, click [Edit] to enter the Edit mode. Clicking [Edit] changes the
document status from the View mode to the Edit mode so that you can cut pages from the document.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.

5 Select the check boxes of the pages that you want to copy or cut, and select [Copy] or
[Cut] from the [Edit] menu.
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* When you have cut pages from the document, proceed to the next step after the process is completed.
* When you have copied pages from the document, proceed to step 8 after the process is completed.

Do not perform any operation while the e-Filing web utility is running busy.
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6 Click [Save] to save the document.
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1item is cut.

The Save Document window appears.

7 Enter the document name in the [Document Name] box and click [Save]. n

Save
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* If you rename the document, it will be saved as a new one. If you do not change the name, the original
document will be overwritten.

¢ The document status is returned to the View mode from the Edit mode

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.

In the Document frame, select the box or folder where you want to store the copied
pages.
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The Document is saved,
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber onz2

Box Marme : Userl2

Box Password ‘ asssss ,

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

10 Click the [Edit] menu and select [Paste].

(@ Etectronic Filing Login
File i o b

Document
18 e-Filing

[ Public Box
E &9 001 User0l
) Foldern1 \—
[ DOC110510 Delete
[ DOC110510-001
E 4§ 002 User02
) Folderoz
| DOC110510-002
%A 003 User03
g 004 Usern4

Invert Selection

Cut
Copy

&l 005 User05 [CIFalderoz
57 006 Userda [[pocii0sio-
& 007 User0? 002

[Scan]

The document containing the copied pages is created in the selected box or folder.
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H Deleting pages from a document
You can delete pages from a document.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document whose pages
you want to delete.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Bax Murnber : on1

Box Marme : Userl1

Box Password © LI

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 In the Document frame, select the document whose pages you want to delete, and click
[Edit].
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The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.
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5 Select the check boxes of the pages that you want to delete and select [Delete] from the
[Edit] menu.
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Cut
Copy

The confirmation dialog box appears.

@ Click [OK].

Message from webpage ==

@ Do you want to delete the page(s)?

The selected pages are deleted.

7 Click [Save] to save the document.
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2 items are deleted.

The Save Document window appears.

8 Enter the document name in the [Document Name] box and click [Save].

Save
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* If you rename the document, it will be saved as a new one. If you do not change the name, the original
document will be overwritten.
* The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.
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H Inserting a blank page into a document

You can insert a blank page into a document. You can select a different size for the blank pages.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document into which
you want to insert a blank page.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Bax Murnber : on1

Box Marme : Userl1

Box Password © LTI

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

In the Document frame, select the document into which you want to insert a blank
page, and click [Edit].
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The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.
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6 EDITING DOCUMENTS

5 Click the space between the pages where you want to insert a blank page.
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The arrow indicators move to the space between the pages where you have clicked.

6 Click the [Layout] menu and select [Insert Blank Page].
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The Insert Blank Page window appears.

7 Select the paper size and orientation of the inserted blank page, and click [OK].

Insert Blank Page

Select the paper size for the blank sheet o insert.

@ Letter (8.5 %11 in) @ Porirait
@ Legal (B.5x14in) @ Landscape;
@ A4 (210 %297 mm)

(@ Staternent (55 x84 in)

©) A3 (287 x 420 mm)

© B4 (257 % 364 mm)

© B5 (182 % 257 mm)

@ Ledger (11 %17 in)

@ Computer (10178 %14 in)

@ Falio (210 x 330 mm)

© A5 (148 x 210 mm)

© B5'SQ(B5x850n)

© 8K (270% 390 rm)

@ 16K (2701195 mm)

© A3WIDE (305 % 467 mm)
(SRR

© 3203450

© 3203460

O (13x1810n)

S

Cancel

A blank page is inserted between the specified pages.
Tip

Its available size differs depending on the model.
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8 Click [Save].
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The Save Document window appears.
9 Enter the document name in the [Document Name] box and click [Save]. n

Save
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* If you rename the document, it will be saved as a new one. If you do not change the name, the original
document will be overwritten.
* The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.
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H Moving pages within a document
You can move pages within a document to rearrange the page order.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document whose pages
you want to rearrange.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Bax Murnber : on1

Box Marme : Userl1

Box Password © LTI

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

In the Document frame, select the document whose pages you want to rearrange, and
click [Edit].
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The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.
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Select the check boxes of the pages that you want to move between other pages and
select [Cut] from the [Edit] menu.
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The selected pages are copied to the clipboard and deleted from the document.

Do not perform any operation while the e-Filing web utility is running busy.

6 Click the space between the pages where you want to insert the copied pages.
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1item is cut,

The arrow indicators move to the space between the pages where you have clicked.

7 Click the [Edit] menu and select [Paste].
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The copied pages are inserted between the specified pages.

8 Continue the procedure from steps 5 to 7 to rearrange the pages.

Editing With Pages in Your Documents 105



9 After you have completed rearranging the pages, click [Save].
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1iterm is pasted.

The Save Document window appears.

1 0 Enter the document name in the [Document Name] box and click [Save].

Save
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* If you rename the document, it will be saved as a new one. If you do not change the name, the original
document will be overwritten.
* The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.
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Moving and Merging Documents

You can move documents between boxes or folders. You can also combine several documents into one document.
P.107 “Moving documents”
P.109 “Merging documents”

l Moving documents

You can move a document from one box or folder to another, to help you manage the documents.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document that you want

to move.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Murmber: 001

Box Narme : Userd1

Box Password : LITTLT)

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Select the check boxes of the documents that you want to move and select [Cut] from
the [Edit] menu.

(3§ Electronic Filing Login
File Edit % g

Document s JUEL Select All
Invert Selection
{8 e-Filing -
[ Public Box e
E & 001 Usernl

() Folderol

[& poc110s10

|y DOC110510-001
& 002 User02
&0 003 Userds
& 004 User04
g 005 Userds
& 006 User0s

Delete

& 007 Usero? [CFaldero1 —
[#poci1os10 [Ipociiosio-
[Scan] ool
1 [Copy]

The selected documents are copied on the clipboard and deleted from the current box or folder.
Do not perform any operation while the e-Filing web utility is running busy.

In the Document frame, select the box or folder where you want to paste the
documents.

(¢ Electronic Filing
File Edit View

& Userdl (2 items)

Documents Preferences Login

Document

= 49 001 User0dl
] Folderol

|y DOC110510-001 e
&f 002 Usernz Quick Start Guide
0 003 Userds B
& 004 User04
g 005 Userds
& 006 User0s
&g 007 Usern?

[FIFalderol

[[pociiosio-
oo1
[Copy]

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Boo Murnber: 00z

Box Narme : Userl2

Buox Password ‘ assese ’

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.
Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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7 Click the [Edit] menu and select [Paste].

(3§ Electronic Filing Login
File Edit

Document el elect All
Invert Selection
{8 e-Filing

[ Public Box

E & 001 Userl
() Folderol k—

[& DOC110510-001 Delete

E 2§ 002 User02
() Foldero2

0 003 Userds

& 004 User04

g 005 Userds

& 006 User0s

&g 007 Usern? [FlFaldernz

Cut
Copy

The documents are created in the selected box or folder.

H Merging documents

You can copy an entire document and insert its pages into another document.
The document that you want to insert is the source document, and the document that you want to merge it into is the
destination document.

Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the source documents.

(@ Electronic Filing

e
Document B eFiling (3 items)
¥ e-Filing

# [ Public Box
&l 001 Userdl
éa 002 User02
&l 003 Userd3 63 ﬁa
éa 004 User04 ﬂ
&gl D05 Userds
éa 006 UserO6
&l 007 Userd?

[FlPublic Bax [0t userol

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Bax Murnber : on1

Box Marme : Userl1

Box Password © LI

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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Select the check boxes of the source documents and select [Copy] from the [Edit]

menu.
(g Electronic Filing Login
File Edit =0
Document o L SelectAll
Invert Selection
{8 e-Filing

[ Public Box
E & 001 Usernl
() Folderol
[@ poc110s810-001

&0 002 Usernz
&7 003 Usern3
&0 004 Usern4
&/ 005 User0s
0 006 Userds
&7 007 Usern?

[CIFoldero1

[¥poc1insin-
ool

-

1 opyl

The selected documents are copied to the clipboard.

Do not perform any operation while the e-Filing web utility is busy.

5 In the Document frame, select the box or folder containing the destination document.

(g Electronic Filing
File Edit

& Usedl (2 items)

Documents Preferences Login

Document

Public Box
= &9 001 User0dl
) Foldero1

|y DOC110510-001
A 002 Usernz
G 003 User0s G
%f 004 UserDs
g 005 Userds
%f) 006 User0s
&g 007 Usern?

[FIFalderol 1
[[pocii0sio-
001

[Copy]

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Bax Murnber : onz

Box Marme : Userd2

Box Password © ‘ LI ’

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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7 In the Document frame, select the destination document, and click [Edit].

SEI tronic Filing Documents | Preferences Login
File Edit

[& Doc1105810-002 (143 Status : View R
Document = Edit
{8 e-Filing \

[ Public Box z

E & 001 User1l
() Folderol

[@ poc1105810-001
E & 002 User0z -
[ Folderoz
@ oociiosio-noe ||
47 003 User03 % m
G 004 User0d 1
%f 005 User0s

0 006 Userds
gi 007 User07?

[Flpages 1 [Flpages 2 [Flpages 2

The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
mode from the View mode.

rl

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.

8 Click the space between the pages where you want to merge the documents.

QEI tronic Filing Documents | Preferences Login
File Edit View Layout ] i

Document E DOCT0510:002 (1/3) Status : Editing

{8 e-Filing A4 4
[ Public Box
E & 001 Userl
() Folderol
[@ poc1105810-001 -
E & 002 User0z L

() Foldernz
DOC110510-002

gi 003 User03
0 004 Usern4
gi 005 User05S
0 006 Userds
gi 007 User07?

R

Fs [Crages 1

The arrow indicators move to the space between the pages where you have clicked.

9 Click the [Edit] menu and select [Paste].

SEI tronic Filing Documents | Preferences Login
File Edit View Layout y P

Document [2eleled] seiect an Status : Editing

Invert Selection
{8 e-Filing

[ Public Box
E & 001 Userl
() Folderol
[@ poc110s10-001
E & 002 User0z L]
) Foldero2
DOC110510-002
&f 003 User0a
&0 004 Usern4
& 005 User0s
&0 006 Userds
& 007 User0?

v

Cut [——
Copy

Delete

[Clrages 2 FY

The copied documents are merged between the specified pages.

Tip

If multiple documents have been copied, the documents are merged in order from the oldest one.
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1 0 Click [Save].

8 Electronic Filing Documents | Preferences Login
File Edit View Layout ] i

Document E DOC1105810-002 (4/5) Status : Editing
{8 e-Filing —
[ Public Box = : ===

E & 001 Userl
() Folderol
[@ DOC110510-001

B 8 002 Userdz [}

() Foldernz
DOC110510-002

ga 003 User03
&g 004 Usern4
ga 005 User05S
0 006 Userds
ga 007 User07?

] »

m

DDageE 1 DPages 2 DPages 3 DPages 4

[Clrages s
i v 4 o

The Save Document window appears.

11 Enter the document name in the [Document Name] box and click [Save].

Save

y =

I '\
DntumemNam@CHDSm-UDQ )

* If you rename the document, it will be saved as a new one. If you do not change the name, the original
document will be overwritten.
¢ The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X], turn the power to the equipment off and then on again.
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SYSTEM ADMINISTRATION

This chapter describes system administration of the e-Filing features.
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Safeguarding Data

An administrator should periodically monitor e-Filing to make sure it has enough hard disk space for everyday operations.
This section describes the administrator’s function that allows you to delete boxes and the unlocking method of the user
boxes which have been locked by incorrect password entries.

P.114 “Erasing boxes”

P.115 “Unlocking user boxes”

M Erasing boxes

You can manually erase boxes in e-Filing if the data has been corrupted, for example, by a hard disk failure and is
therefore no longer usable.

Log on to the Administrator page.
P.37 “Logging in as a system administrator”
The Box Management page is displayed.

* ltis recommended to archive the documents in the boxes before deleting them. Once the boxes have been
deleted, you cannot restore the documents in the boxes.
P.73 “Archiving documents”
* The Backup/Restore utility included in the Client Utilities CD-ROM allows you to back up data in the boxes.
Tip
You can display the Box Properties window by clicking the box number or box name link.

2 Select the check boxes of the user boxes that you want to delete and click [Delete].

(@ Electronic Filing

Box Management
eFiling Disk Space Available : 10142 MB

Stored Data | Data Type | Data Size | Remarks
Box | Shared File | ar e |

({Delege [ Unlock
A X A Box Number Box Name Used capacity Status.
1 z oo1 Usernl 57 MB
I o0z usernz SKB
[ o3 Userii3 5KB
=] I 004 Userns 40 1B
] I ons Userds 5K8
=] I 008 userns 5KB
o7 Userd? 5K8

D|%1

Top | Help

The confirmation dialog box appears.

For more information about the Box Management Subtab, see the following page:
P.41 “[Box Management] subtab”

3 Click [OK].

Message from webpage

u@w Do you want to delete the item(s)?

W

The selected user boxes are deleted from e-Filing.
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H Unlocking user boxes

When the Lockout Setting of e-Filing is set to “Enable” in the Password Policy, if an incorrect user box password is entered
a specified number of times consecutively, the user box is locked so that it cannot be used for a certain time. The system
administrator can unlock user boxes which have been so locked.

The Password Policy can be set in TopAccess. For details of the password policy, refer to the TopAccess Guide.

Log on to the Administrator page.
P.37 “Logging in as a system administrator”
The Box Management page is displayed.

Tips

* For locked user boxes, “Locked” is displayed in the Status.
* You can display the Box Properties window by clicking the box number or box name link.

2 Select the check box of the user box that you want to unlock, and the click [Unlock].

= -

(@ Electronic Filing

Box Management
e-Filing Disk Space Avaiable : 10142 MB

Stored Data | Data Type [ Data Size [ Remarks
Box | Shared File | a7 ue |

Rox Number Box Name Used capacity Status
201 Usernl 57 MB

o0z Usern2 SKB

o003 Usern3 5KB
Usernd a0 MB Locked

ons Userns 5KB

FIEIEIEIEIR o

o
2
=

oog Userog 5KB

EI on7 Usern? 5KB
The lock of the selected user box is released.

For more information about the Box Management Subtab, see the following page:
P.41 “[Box Management] subtab”

Top | Help
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